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QUICK REFERENCE FOR MICRO-ErrorChecker Plus 2006, v.2006

PLEASE RUN THE INSTALLATION PROGRAM
See User's Manual, page 9

1. Equipment:

Minimum: Windows 95/98/NT/2000/XP Compatible Computer;
Minimum of 4 meg RAM memory, 
Hard drive,
Windows Compatible Printer.

Recommended: Windows 95/98/NT/2000/XP Compatible Computer,  
16 meg or more RAM memory;
Hard drive or network connection,
Windows Compatible Printer.

2. Preparing to use the software:

If you received a CD, please keep it in a safe place.  If you downloaded the program file from
the www.sewarner.com website, make a backup copy of the downloaded program file and
keep it in a safe place..

3. Commands:

All commands for MICRO-ErrorChecker Plus 2006 may be displayed on the screen.  The
frequently used commands may remain on the screen in the Tool bar; however, all commands
may be displayed by pressing the F10 key or by clicking on the '?' mark  in the Tool bar or by
selecting the Help menu and choosing the Commands screen item.  Don't worry about
forgetting the commands--they are just a keystroke away at all times.

4. Dual pitch (characters per line):

MICRO-ErrorChecker Plus 2006 displays either a Pica (10 characters per inch) or an Elite
(12 characters per inch) typing scale on the screen.  With elite, margins are set at 12  (1" left
margin)  and at 90 (1" right margin); the left and right marginal areas appear on the screen but
may not be used.  With Pica (10 characters per inch), margins are set at 10 (1" left margin)
and at 75 (1" right margin); you have access to the entire left marginal area and half of the
right margin (up to space 80 on the scale).  MICRO-ErrorChecker Plus 2006 only allows a
maximum of 80 characters per line for both Pica and Elite pitch.



2

5. Printers:

The pitch of the printer will automatically change from Pica (10 characters per inch)  to Elite
(12 characters per inch) if you have selected the appropriate printers through Windows
95/98/NT/2000/XP.  MICRO-ErrorChecker Plus 2006 is completely dependent upon the

 selection of the printer through Windows 95/98/NT/2000/XP.  (See User's Manual–Trouble
Shooting,  section on Printing, page 104.) 

6. Format menu:

The Electronic Typewriter mode provides for 7 format items:  1) Underline mode
[Ctrl+Shft+U], 2) Bold mode [Ctrl+Shft+B], 3) Centering [Ctrl+Shft+C], 4) Expand mode
(spread typing) [Ctrl+Alt+E], 5) Right justify [Ctrl+Alt+J],  6) Superscript mode
[Ctrl+Alt+K], 7), Margin centering [Ctrl+Alt+M].  In the Simplified Word Processor mode,
four  additional format items are available: 8) Hanging indent [F8], 9) Insert mode
[Ctrl+Alt+I], 10) Reformat paragraph [Ctrl+Alt+F], and 11) Compress page [Ctrl+F8] (See
User's Manual, CTRL+F8, page 42).  All format menu options toggle on or off using the
same menu item or control key combination.  The status of the items selected will be shown in
the Tool bar with the exception of INSERT mode and STRIKEOVER mode which is shown
at the right side of the status bar.  Single time functions such as margin centering, reformat
paragraph, and compress page perform the function without further indication.  NOTE: The
Electric Typewriter mode does not provide for any of the above format items; however, all
modes have the basic format features of add/delete underline or bold, set pitch, set line
spacing, set margins, set and clear tabs.  The Electric Typewriter mode and the Electronic
Typewriter mode with wordwrap OFF, also have a margin release available.

7. Timing:

MICRO-ErrorChecker Plus 2006 provides for 3 timing modes:  1) Timer OFF, 2)
Continuous timing, and 3) Countdown timer (stopwatch feature).  The timing mode is selected
prior to the beginning of each activity, and may not be changed until a new activity is started.

8. Correction:

MICRO-ErrorChecker Plus 2006 provides for correction to be either ON or OFF.  If
correction is ON, the student will be able to edit previously typed text.  If correction is OFF,
no editing of previously typed text will be possible.  The correction mode is set prior to
beginning each activity, and may not be changed until a new activity is started.  Status of the
correction mode is printed in the heading of each document or activity and recorded in the
student record.
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9.  Document and activity information (heading):

If the document has previously been saved, the name of the document is printed at the right on
the first line of page 1.  In addition, all page headings contain the following information: 
Name, Time, Date, Page number, Mode designation (T=Electric typewriter; ET=Electronic
typewriter; WP=Simplified Word Processor), Total error check data--error checks since
current document was created and the total error checks for this key name in the student
record (TCk 2/4 means this specific document has been error checked twice since it was
created; however, the key name for this document has been used to error check four times),
Correction ON or OFF, Wordwrap ON or OFF, Edits (number of times a document has been
reloaded), Total words typed, Time used (minutes:seconds), and Gross Words per Minute
(GWPM).

If the document has been error-checked the following are also included:  Number of errors,
Net Words per Minute (NWPM), Cutoff Words per Minute (COWPM), and Checks (the
number of times the error-checker has been used on this document.  This Cks number should
be the same as the first number shown on line 2 in the TCk area.  If the Cks number is less, the
student has error checked an "old" saved document.  This procedure should be discouraged
since teacher control over "cheating" is severely compromised!).  In order for the teacher to
maintain control, each time any editing takes place after an error-check, the Errors, NWPM,
and COWPM items will be removed from the heading.  These items will not reappear until
after the next error-check is done.

MICRO-ErrorChecker Plus 2006 is designed to help the teacher improve the student's
proofreading skill.  To be certain that a student is proofreading their own work, and has not
modified a document after it has been error-checked, the teacher should require that the Edits
counter not appear in the heading, the Checks counter should be 1, the TCk should be 1 for
this document, and the error count information appears in the heading of the document.

NOTE:  The heading may not be printed, if so desired; however, for all assignments to be
turned in, it is highly recommended that the heading ALWAYS be required by the teacher.

10. Word counts and word per minute rates:

At any time while a timing function is operative, you may see your Word Per Minute
calculation (including time used and total words typed) by pressing ESC.  You will be sent to
the Document data dialog, you may return to the your current document by again pressing
ESC or clicking on the Cancel button or double-clicking on the Return to current job radio
button.

11. Saving:

You will need an additional formatted disk, or a personal storage location on the hard drive or
network, before you may save any documents that you have typed.  Label your storage disk
appropriately.  See your Windows 95/98/NT/2000/XP user's manual  for instructions on
formatting storage disks.
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12. Business forms:

MICRO-ErrorChecker Plus 2006 includes 18 commonly used business forms.  You may create and
add additional forms by typing the form and saving by pressing Ctrl+Alt+F9.  

NOTE:  Some of the business forms are designed as simulation forms and are used exclusively for
educational purposes.  (For example: postal cards and envelopes.)

13. Orientation:

It is recommended that each user spend a few minutes reviewing the commands available in MICRO-
ErrorChecker Plus 2006.  From the Tool bar, click on the Question Mark (?).

14. Maximum document size:

MICRO-ErrorChecker Plus 2006 provides six 66-line pages in memory.  If a document is longer than
six pages, you will need to save it under more than one document name.  (For example an 18-page
document could be saved as follows:  pages 1-6 as JOB1A, pages 7-12 as JOB1B, and pages 13-18 as
JOB1C.)  NOTE:  If documents longer than six pages are to be error-checked, it will be necessary to
have a separate key for each data file, and the student data files will need to begin/end at the same word
as the respective key.

15. Underlining and bold:

In the Electric typewriter mode, underlining is done exactly as on a standard typewriter
(backspace and strike over with the underscore key);  with the Electronic typewriter and
Simplified Word Processor modes, underlining may be done automatically.  (Press Ctrl+Shft+U
or select Underlining mode from the Format bar or click on the Underline mode button on the Tool
bar.)  NOTE:  The proper printer must have been properly installed through Windows
95/2002/NT/2000/XP so that underline and bold will be printed properly.  Similarly Ctrl+Shft+B
or select Bold mode from the Format menu or click on the Bold mode button on the Tool bar
selects automatic bold in Electronic typewriter and Simplified Word Processor modes, or you
may overstrike the characters with the Shft-Underscore or Ctrl+Underscore; overstriking the
characters with the Shft+Underscore or Ctrl+Underscore will add or remove the underline or
bold from the characters the same as with the Electric typewriter mode.

16. Superscripts

MICRO-ErrorChecker Plus 2006 supports superscripted characters.  Superscripted characters are
entered by pressing Ctrl+Alt+K (to turn superscript on), typing the desired characters, and pressing
Ctrl+Alt+K (to turn superscript off.)  You may also use the Tool bar button SU  or the Format menu. 
NOTE: The proper printer must have been previously installed by Windows 95/98/NT/2000/XP.

17. Block operations:

When using the Simplified Word Processor mode, text may be marked and subsequently moved,
copied, or deleted.  Mark the required text with your mouse and then select the appropriate Cut,
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Copy, or Paste function from the Edit menu.  NOTE:  When a block of text is copied, the characters
that are copied are not added to the word count, and a 'c' is appended to the word count to indicate the
presence of copied characters and an asterisk (*) is placed at the beginning of the “Saved as” filename
in the student record.

18. Margins, tabs, pitch, and spacing:

Each line of a MICRO-ErrorChecker Plus 2006 document stores information concerning margins,
tabs, pitch and spacing for that particular line.  Blank lines inherit the above information from the last
preceding non-blank line and, therefore, changes in margins, tabs, pitch, or spacing must be made on a
non-blank line, or some character or space must be typed on the line prior to moving to a new line.

19. Hanging indent:

MICRO-ErrorChecker Plus 2006 provides for a Hanging Indent mode.  Pressing F8 toggles hanging
indent mode ON or OFF.  Pressing F8 at the left margin will cause hard returns to go to the old left
margin (indicated on the typing scale by the character I) and soft returns to go to the first tab position
(now indicated as the left margin with the character L on the typing scale.)  Pressing F8 to the right of
the current left margin will cause hard returns to go to the old left margin (indicated on the typing scale
by the character I) and soft returns to go to the current cursor position(now indicated as the left margin
with the character L on the typing scale.)  Hanging indents may not be set to the left of the left margin. 
Pressing F8 when the character I appears on the typing scale (indicating hanging indent is ON) will
turn hanging indent OFF, and restore the margins and tabs.

20. Error-checking:

Students request an error-check of their documents by pressing CTRL-E in the open typing screen or
clicking on the Check document for errors when at the Document data dialog.  At the Open KEY
File dialog, the student then selects or types the name of the key file which has been previously prepared
by the instructor.  

21. Key creation:    

Keys are created by the instructor by accessing the Key Builder from the Teacher menu item or
from the bottom of the Document data dialog box after the Teacher Menu button is selected and
the password entered.   If the Key builder menu item is disabled, select Password and enter your
password.  Return to the Teacher menu and select Key Builder to enter the key builder program.

22. Student records:

Parameters for the maintenance of student records (number of scores to record, method of ranking
scores, penalties for errors, etc.) are set by the instructor in the Edit/Create Class portion of the
program which is accessed from the Teacher menu. If the Edit/Create Class menu item is disabled,
only the current student’s record that will be displayed by selecting from  the File menu the Access
student record item..  If you desire to be able to display any student record, first select Password
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 and enter your password then return to the Teacher menu and choose Dbase Utility item to enter the
Dbase Utility program which contains all student records.

Students may access their own Student Record by pressing Ctrl+F6 while in the text-entry screen or
select from the File menu the Access student record item.  Students may display or print their drill,
production, and exam scores as well as backup their records.

Teachers may access student records by selecting Dbase Utility from the Teacher menu after
authorization by entering the password.  Through this option teachers have full control of the class
records, permitting them to modify data records, backup/restore data records, modify class lists,
transfer student records to other classes, display/print records and passwords, and generate class
summary reports. 

23.  Verification of paths and user access rights:

The installation program creates two text files (MECplus2006prog.txt and MECplus2006setup.txt)
and copies these files to the C:\Program Files folder.  MEC Plus 2006 v.2006 requires that these two
files be available.  The MECplus2006prog.txt file contains the complete path to the Mec.exe
executable program file and the MECplus2006setup.txt file contains the complete path to the Class
Setup folder where the Class Setup (defaults.xxx) files are located and also where the Records folder
and the Keys folder are generally located.  In addition to these two text files, the Class Setup file
(defaults.xxx) contains four related path fields:

Program Path:  This path is generally the same path as contained in MECplus2006prog.txt file.. 
This path is used primarily to locate the business forms.

Records Path:  This path is generally the same path as contained in the MECplus2006setup.txt file
plus the addition of the “...\records\” folder at the end of the path.  The path is used to locate the
records folder where the class lists (classrec.xxx) files and the student records are maintained.

Keys Path:   This path is generally the same path as contained in the MECplus2006setup.txt file plus
the addition of the “...\keys\” folder at the end of the path.  The path is used to locate the keys folder
where the error-checking key files are located.

Storage Path: This path is where the student saves his/her document files.

NOTE: When a Class Setup file is created and saved, the program will test the compatibility of the
paths and the User Access Rights for the teacher. To test for a student, logon the network as a student
and enter “INSTRUCTOR” for the name when initializing MEC Plus 2006.
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 FEATURES OF MICRO-ErrorChecker Plus 2006

MICRO-ErrorChecker Plus 2006 works like a simplified word processor, an electronic typewriter, of an
electric typewriter.  The features of each mode and the general features of the software are listed below:

Electric typewriter features:

Margin setting
Tab setting
Tab clearing: (single or all)
Line spacing: (single, double, or triple)
Pitch setting: (pica or elite)
Horizontal/Vertical centering (backspace from center)
Word underlining: (backspace and strikeover with underscore key)
Superscripted characters:

Electronic typewriter features:

All electric typewriter features plus:
Wordwrap
Automatic Centering 
Center between margins
Expanded text (spread typing)
Bold characters
Right justification
Automatic underline
Decimal tabs

Simplified Word Processor:

All electronic typewriter features plus:
Insert mode
Hanging indent
Paragraph reformat 
Block operations:  (copy, move, delete)
Find/Replace function

Content and format error-check of student documents:

Immediate student feedback
Errors marked on printed documents
Error-check data recorded in the student record

Student records:

Class roll maintenance--add/delete/modify student names
Logon password [ON/OFF]
Record drills, productions, and exams
Rank drill scores by GWPM, NWPM, or COWPM
Display/Print student records and passwords
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Backup student records
Transfer student records from one class to another
Teacher editing of student records

Additional features (available in all modes):

Alert that document has not been saved
Printing document

Entire document
Selected pages or activities

Cancel of printing
Saving and loading of document files
Deleting document files
Insert blank spaces (characters)
Insert blank lines
Deleting characters
Deleting lines
Display of document names on data disk
Edit Counter (number of times a document has been reloaded)
Commands displayed on screen

Frequently used commands are available in the tool bar.
All commands may be displayed from a help command or the '?' mark

Review work in progress
Select from 18 commonly used business forms
Create and add business forms to the software.

Selectable features:

Correction feature [ON/OFF]
Wordwrap feature [ON/OFF]
Timer [ON/OFF]
Timer display [ON/OFF]
Stopwatch (countdown timer)
Multiple activities in one document (You may include up to six separate timed activities in a single

document file. Each timed activity begins on a new page.)
Print student identification headings
Paper saver printing
Bold, underline, and superscript

Other notable features:

A student CANNOT copy and use another student's work
All timing and WPM calculations handled by the computer
Heading include: Student name, Time, Date, Words typed, Time used (minutes:seconds), GWPM,

Wordwrap (ON or OFF), Correction (ON or OFF), and Edits (number of editing sessions--if none,
no display, Current document name (if saved), and Mode of operation.  For documents which have
been error-checked the heading will also include: Number of errors, NWPM, and COWPM.

Six 66-line pages in memory available for each document
Automatic skip from end of line 60 to beginning of line 6 on next page when using the wordwrap

feature.
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INSTALLATION OF MICRO-ErrorChecker Plus 2006
SOFTWARE

CD INSTALLATION OF MICRO-ErrorChecker Plus 2006 SOFTWARE

NOTE:  If this is to upgrade from MEC 98 or MEC 2002, UNINSTALL the old version. 
(Note: No previous class setup files, student records, or keys will be changed by Uninstall.)

Insert the MICRO-ErrorChecker Plus 2006 CD into your CD drive (AutoRun CD):
(If AutoRun fails, select Start -> Run; then enter the CD drive letter:setup.exe)

Click on the "Install Licensed Program" or the "Install Demo/Preview Program" button.

Follow the directions on the Install screens.

INSTALL DOWNLOAD OF MICRO-ErrorChecker Plus 2006 SOFTWARE (www.sewarner.com)

NOTE:  If this is an upgrade from MEC 98 or MEC 2002, UNINSTALL the older version. 
(Note: No previous class setup files, student records, or keys will be changed by Uninstall.)

 
Open the “download folder” and double click on the downloaded file (mec2006.exe) to extract the
insallation setup files.  Now, open the  ‘MECPlus2006’ folder.  Double click on the  setup.exe to
install MECPlus 2006.

Follow the installation directions on the Install screens.

NETWORK INSTALLATION

If a single installation of MICRO-ErrorChecker Plus 2006 has been installed on a  network
server, the following should be done:

Create a shortcut icon from MEC2006.exe and copy this shortcut to the desktop of each
workstation or place a startup item in your program launcher.

Please note that a network installation is only appropriate when MICRO-ErrorChecker Plus
2006 has been installed onto a network server from which it is loaded into individual stations at run
time..  If your class room is set up such that each individual station (which may be connected to a
network) has its own copy of MICRO-ErrorChecker Plus 2006 installed on its own hard drive,
you should perform a standalone (hard drive) installation of MICRO-ErrorChecker Plus 2006
onto each of these stations.
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THE INSTALLATION PROGRAM

To install MICRO-ErrorChecker Plus 2006 to your hard drive or network, you must run the
installation program.  NOTE: Make sure no other applications are running while installing this
software.

The installation paths for MICRO-ErrorChecker Plus 2006  are as follows:

Hard drive standalone installation:  

Choose Destination Location: *
C:\Program Files\MECPlus 2006\ (Program folder location)   

Choose Class Defaults Storage Location: **
C:\Program Files\MECPlus2006Setup\ or
C:\MECPlus2006Setup\ (Location of class lists, class setup files,

student records and error checking keys.
This may be a different folder on the C
drive.) 

*  The path selected will be the path contained in the MECplus2006prog.txt file.
**The path selected will be the path contained in the MECplus2006setup.txt file.

Hard drive installation of program  /  network location for Class Defaults:  

Choose Destination Location: *
C:\Program Files\MECPlus 2006\ (Program folder location)   

Choose Class Defaults Storage Location: **
 (Server Drive Letter):\(Server path to program folder):

For example:
X:\ ... \MECPlus2006Setup\ (Location of class lists, class setup files, student

records and error checking keys) 

*  The path selected will be the path contained in the MECplus2006prog.txt file.
**The path selected will be the path contained in the MECplus2006setup.txt file.
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THE INSTALLATION PROGRAM

To install MICRO-ErrorChecker Plus 2006 to your hard drive or network, you must run the
installation program.  NOTE: Make sure no other applications are running while installing this
software.

The installation paths for MICRO-ErrorChecker Plus 2006  are as follows:

Hard drive standalone installation:  

Choose Destination Location: *
C:\Program Files\MECPlus 2006\ (Program folder location)   

Choose Class Defaults Storage Location: **
C:\Program Files\MECPlus2006Setup\ or
C:\MECPlus2006Setup\ (Location of class lists, class setup files,

student records and error checking keys.
This may be a different folder on the C
drive.) 

*  The path selected will be the path contained in the MECplus2006prog.txt file.
**The path selected will be the path contained in the MECplus2006setup.txt file.

Hard drive installation of program  /  network location for Class Defaults:  

Choose Destination Location: *
C:\Program Files\MECPlus 2006\ (Program folder location)   

Choose Class Defaults Storage Location: **
 (Server Drive Letter):\(Server path to program folder):

For example:
X:\ ... \MECPlus2006Setup\ (Location of class lists, class setup files, student

records and error checking keys) 

*  The path selected will be the path contained in the MECplus2006prog.txt file.
**The path selected will be the path contained in the MECplus2006setup.txt file.
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Network installation of program:  

Choose Destination Location: *  
(Server Drive Letter):\(Server path to program folder):
for example:  

X:\ ... \MECPlus2006\ (Program folder location)

Choose Class Defaults Storage Location: **  
(Server Drive Letter):\(Server path to program folder):
for example:  

X:\ ... \MECPlus2006Setup\ (Location of class lists, class setup files,
student records and error checking keys)  

*  The path selected will be the path contained in the MECplus2006prog.txt file.
**The path selected will be the path contained in the MECplus2006setup.txt file.

NOTE:  For Network Installations, change the drive letter and paths according
to your network installation policies and procedures.  Consult with your school's
network administrator.

NOTE: The two text files mentioned above (MECplus2006prog.txt and MECplus2006setup.txt)
are critical to the operation of MEC Plus 2006 v.2006.  Be sure the paths are correct.  You may
change the path simply by double click on the file, making the necessary changes and then re-saving
the file. The installation program will also create any subdirectories/folders that do not exist before
copying the files to your hard drive.  If at any time during the installation process you have made a
mistake, Cancel the installation and re-run the installation again.

The paths contained in the MECplus2006prog.txt and MECplus2006 setup.txt files will be tested
for compatibility with MEC Plus 2006 and with the paths identified in the Class Setup file when
created and saved.  (See item 23 in the Quick Reference section, page 6.).  

 A test for path compatibility and User Access Rights can be done at any time by logging on to the
network as a Teacher and then launching MEC Plus 2006 and when initializing MEC Plus 2006,
enter “INSTRUCTOR” iin the name box.  Also, you can test as a Student the same compatibility
and User Access Rights by logging on the network as a Student and then when initializing MEC
Plus 2006, enter “INSTRUCTOR” in the name box.  If the program detects any User Access
Rights problems, see Appendix A of this User’s Manual.  The program will notify you of each User
Access Rights problem and then terminate the program so that you may correct the problem.  The
path compatibility feature displays the following display:
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You will note that in the display above, the two paths read from the MECplus2006prog.txt and the
MECplus2006setup.txt files are displayed and compared with the paths indicated in the Class Setup
file created for this class.

When the User Access Rights appear to be correct, the following message appears:
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The above dialog box appears and gives specific suggestions for the paths (installation locations) for
MICRO-ErrorChecker Plus 2006.   This box also shows the specific User Access Rights and File
Attributes that should be set for both the Teacher and Student groups.

Installation Welcome screen.
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Destination Selection Screen:

Click NEXT to continue with the
installation program.  You should NOT
change the Destination Directory unless
you are certain a different location is
required for your installation.

Class Defaults Location Selection
Screen:

Click NEXT to continue with the
installation program.  (This parameter
should be the same as the location
designated on the previous screen unless
MICRO-ErrorChecker Plus 2006 is
installed on individual hard drives and the
class default files are being stored on a
network location.

Setup Type

Select TYPICAL, CUSTOM, or
COMPLETE and click on
NEXT to continue with the
installation.

Typical Installs all program files to the hard drive or network server
specified in the Destination Directory on the previous screen. 
(Requires about 3 Meg of disk space.)
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Custom You may select to install either or both of the following: Program Files
(requires 3 Meg of disk space) Help Files (User's Manual--requires 1 Meg
of disk space)

Complete Installs both the program files and the User's Manual.  Requires about 3
Meg of disk space for the program files and an additional 1 Meg of disk
space for the User's Manual.  You may prefer this option if you will be
printing additional copies of the User's Manual for use within the licensed
school.

After selecting the desired options, the installation program will copy the appropriate files. 
A final message indicating successful completion of the installation program will then
appear.

After the installation program is complete you may run MICRO-ErrorChecker Plus
2006 by selecting MICRO-ErrorChecker Plus 2006 from the START -->
PROGRAMS or by clicking on a newly created shortcut placed on the desktop or by
selecting a startup item from a program launcher..

The Uninstall Program

If it is desired to uninstall MICRO-ErrorChecker Plus 2006 software, you may use
Add/Remove Programs from the Windows 95/98/NT/2000/XP Control Panel.  To
uninstall MICRO-ErrorChecker Plus 2006 from a network server, the uninstall must be
done from the same workstation as was used in the installation.
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EQUIPMENT   REQUIREMENTS

Minimum: Windows 95/98/NT/2000/XP, 486 processor, 
66 Mhz compatible computer, 
Minimum of 4 meg RAM memory,
Hard drive,
Windows compatible printer.

Recommended: Windows 95/98/NT/2000/XP, 
Pentium III compatible computer,
16 meg or more RAM memory,
Hard drive or network connection,
Windows compatible printer.
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CREATE INDIVIDUAL CLASS FILES

Each class using MICRO-ErrorChecker Plus 2006 is required to have its own individualized
class file which includes all of the specific standards for that particular class.

Creating an individual class file:

NOTE:  Each class that is created for MICRO-ErrorChecker Plus 2006 has an independent
class file so that different standards may be used in different classes.  Each class file may have a
separate password.  Teachers should be careful to choose passwords that they will not forget;
and if someone other than the teacher is creating the class files, that individual should make
certain that the password(s) are given to the appropriate teachers.  It is also recommended that
the class file contents be noted so that a written copy of the all settings are available to the
instructor.

REMEMBER:  It is necessary that an individual class file be created  before MICRO-
ErrorChecker Plus 2006 is used in the classroom.

Procedure for creating the first individual class file:

1, Start MICRO-
ErrorChecker Plus 2006 by
clicking on the Task bar Start
button; select Programs;
choose MICRO-
ErrorChecker Plus 2006.

1. Enter the class number of
the class for which you want
to create a class file.

Note: The release date
of this program is given
at the bottom of the box. 

2. Since a class with that 
number does not exist; the
Class Does Not Exist dialog
appears:

Click Create a New Class
button.
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3.  Enter the Password: 

NOTE:  The password
is:  "PASSWORD"

After clicking on OK, you
will be required to enter a
new password for this
new class.  The new
password cannot be the
word "PASSWORD"

You will be reminded to REMEMBER your new
password for this class.
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4.  Complete the Class Setup Dialog

NOTE:  You will notice the Class Setup Dialog box appears.  All of the data in this dialog
box is the default values set by the installation program. 

 

a)
b)
c)
d)

e)

f)
g)

h)

i)

j)
k)

NOTE: An alternative method of completing the items in this Class Setup Dialog, is to click on
the Help dialog button on the bottom row.  Several Help screens are then available with on
screen help information.  ALL CHANGES MADE TO ITEMS WHILE A HELP SCREEN IS
ACTIVE RESULTS IN THE CHANGES BEING MADE TO THE CLASS SETUP DIALOG.

a) Logon Procedures: 

There are three drop-down menus from which you must make a selection.  

1)  The first drop-down item allows you to select whether you would
prefer that the student type his/her name or select the name from a list
of all students currently enrolled in the class each time they begin
using MICRO-ErrorChecker Plus 2006.  The options are:  Type
NAME or Select NAME from LIST.

2) The second drop-down item allows you to select whether you will require students
to enter a password when accessing the software.  There are nine different options
for passwording student access to the software.  Each option generates a distinct
list of three character passwords.  If this option is selected, the teacher will need to
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add students through the Dbase Utility item of the Teacher menu, and provide the
passwords to the students.  (The passwords may also be printed through the
Dbase Utility item of the Teacher menu.)

3) The third drop-down menu allows you to select whether you would like the
software to automatically create student records.  If this option is set to Password
NO, the instructor will need to add students through the Dbase Utility item of the
Teacher menu.  This option is automatically set to Auto Logon NO if the student
logon is passworded in the password drop-down menu.

b) Accelerate Video:

Check to accelerate operation speed on 486 and slower pentium computers.  This
mode is actually perferred for all computers.

c) Document preparation:

There are eight (9) items which need to be considered in this section:

1) The first item is a drop-down menu for the default pitch for the typing scale.  You
may select either PICA (10 pitch) or ELITE (12 pitch).  The pitch refers to the
number of characters per inch.  NOTE: The setting of the pitch is merely the
default setting for MICRO-ErrorChecker Plus 2006; the student may change the
pitch while using the software.  

2) The second item is a drop-down menu for selecting the screen font size to be used.
Select your personal preference; however, users of Windows NT/2000/XP
Workstation should select a screen font followed by the (NT) indicator.  Windows
95/98 users may select any of the fonts.  NOTE: All documents will still print in
Pica (10 cpi) and Elite (12 cpi).

3) The first three check boxes concern the availability of operational modes: Word
processor, Electronic Typewriter, and Typewriter.  (NOTE: operational mode
selections may not be changed during the use of the software.)  The next four
check boxes are for setting the defaults for Correction (ON or OFF) and
Wordwrap (ON or OFF).  The default settings for Correction ON/OFF and
Wordwrap ON/OFF may be changed by the student before starting each new
activity.  (NOTE: These default settings cannot be changed during the
completion of an activity.) 

d) Sartup default mode:

If more than one operational mode has been checked as being available,
you may  select which mode should be the default startup mode each time
MICRO-ErrorChecker Plus 2006 is started.  Students will be able to
change the mode of operation at the beginning of each new document or
activity with the selection they have made being printed in the document
information heading.
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e) Record keeping:

There are four drop-down menus from which you must make a selection.

1) The first drop-down menu is normally set to Record Scores YES.  If there are
times when the instructor would like the students to create and error-check
documents without having the results stored in the student record, this option
would be changed to Record Scores NO.  If this option is set to Record Scores
NO, students added to the class will not have a student record created for them
until the option is set back to Record Scores YES.

2) The second drop-down menu determines which method the results will be sorted in
the student record.  Timed writings, paragraph drills, and line drills will be sorted
in the student record according to Gross Words per Minute (Rank by GWPM),
Net Words per Minute (Rank by NWPM), or Cutoff Words per Minute (Rank
by COWPM). 

3) The third drop-down menu determines which drill and timed writing activities are
recorded in the student record.  The four options are: Record ALL, Record
FIRST (use the first attempt), Record BEST (use the best attempt), and Record
LAST (use the most recent attempt).

4) The fourth drop-down menu allows three options for backing up student records. 
You may select Backup AUTO (automatic backups are made), Backup MENU
(students make backups of their own records when they desire) and Backup NO
(no backups are made).

f) Class standards:

There are four items to be set in this section.

1) The first item is for number of words subtracted per error for Net Words per
Minute (NWPM) calculation: This is the number of words which will be
subtracted from the total words typed for each error.  The resulting number of
words will be used to calculate the Net Words per Minute rate.  The value may be
set to any number between 1 and 20 (the traditional penalty  is 10).

2) The second item is for the Cutoff Error Number.  This is the maximum number of
errors that are acceptable in a document for the Cutoff Word per Minute
(COWPM) calculation.  Keystrokes up to the Cutoff Error Number will be
counted; this number of keystrokes and the total time used for the entire activity
will be used to calculate the Cutoff Word per Minute rate.  This value may be set
to any number between 1 and 20.  If you do not want to use a Cutoff Word per
Minute rate for grading purposes, leave the value set at 20.

3) The third item is the Maximum Errors per Minute allowed.  Select the maximum
number of errors per minute that will be permitted for a timed writing or
paragraph drill to be included in the student record.  Timed writings and
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paragraph drills that exceed this maximum number of errors per minute will not
 be included in the totals and averages given in the timed writing and paragraph
 drill summaries.

4) The fourth item is the Number of Scores to Average for drills and timed writings. 
Select the number of scores which you wish to have used in calculating the totals
and averages for timed writings, paragraph drills, and line drills.  This selection
may be any number from 1 to 10.

g) Minimum time:

Select the minimum time required for a timed writing or paragraph drill to
be included in the student record.  Timed writings and paragraph drills
that do not meet or exceed the set time length will not be included in the
totals and averages given in the timed writing and paragraph drill
summaries.  This selection may be any number of minutes or seconds.

h) Paths:

There are four paths in this section.  These paths are completed from the
paths used in the installation of  the software.

1) The first path is the Forms Path.  This path is for locating the business forms
which are loaded by the installation program into the program location.  If you
change this path, be sure that the complete path to the business forms is correct. 
The path must contain the drive letter and the complete subdirectory/folder path.

2) The second path is the Records Path.  If you change this path, be sure that the
complete path is correctly entered.  The path must contain the drive letter and the
complete subdirectory/folder path.  For example:

on a hard drive:  C:\Program Files\MECPlus 2006defaults\RECORDS\
on a network:  F:\COURSES\MECPlus 2006defaults\RECORDS\

3) The third path is the Keys Path.  If you change this path, be sure that the
complete path is correctly entered.  The path must contain the drive letter and the
complete subdirectory/folder path.  For example:

on a hard drive:  C:\Program Files\MECPlus 2006Setup\KEYS\
on a network:  F:\COURSES\MECPlus 2006Setup\KEYS\

4) The third path is the Storage Path.  If you change this path, be sure that the
complete path is correctly entered.  The path must contain the drive letter and the
complete subdirectory/folder path.  For example on a hard drive installation the
students might be saving to:

a floppy drive:  A:
a network server:  H:
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NOTE: The Records path and the Keys path would normally be the same path as
is recorded in the MECplus2006setup.txt file created during the installation
process.

i) May change storage path:

This option allows you to designate whether the Storage Path is mapped
directly to the student's storage location, or whether each student will need
to designate their own sub-folder from a specified location.  NOTE:  Some
systems will not permit the automatic mapping of the storage drive
directly to the students storage area; therefore, this must be set to YES
on such systems..

j) Timing Methods:

This section contains 3 buttons:

1) Timing Method 1:  This is the preferred Timing Method (use of the standard
system timer interrupt) as long as the operating system and/or another application
has not intercepted this interrupt before MEC Plus 2006.  If timing of activities
does not work or is erratic, select either the Timing Method 2 or Timing Method
3.

2) Timing Method 2:  This Timing Method uses the same system timer interrupt
used in Timing Method 1; however, the method of extracting the current time is
different.  If the timing of activities does not work or is erratic when using Timing
Method 1 or Timing Method 2, select Timing Method 3.

3) Timing Method 3:  This Timing Method reads the time as each key stroke is
made.  The standard system timer interrupt is not used.

k)  Class Code and dialog buttons:

This section contains 6 items (a Class Code field and 5 dialog buttons).

1) The first item is used to change the Class Code.  The Class Code must be a
number from 1 to 999.  NOTE: If you have several classes that need to have
class files created, an easy way to do this is to save the first class file (press
SAVE button) then change the Class Code to the new class and make any other
modifications to this dialog and then SAVE.  You may repeat this procedure for
as many classes for which you have to create new class files.

2) The second item is the Change Password dialog button.  Select this dialog button
if you want to change the current password to a new password for this class.

3) The third item is the Help dialog button.  Select this dialog button if you want
additional on screen Help for the items in the Class Setup Dialog.  NOTE: Any
changes made while the Help screen is active generally DO CHANGE the items
in the Class Setup dialog.  Suggestion: Click on this Help button and look at all
the Help screens provided.
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4) The fourth item is the Cancel dialog button.  If this button is selected, all changes
previously made (but not yet saved) in the Class Setup Dialog are canceled.

5) The fifth item is the Save dialog button.  All changes made in the Class Setup
Dialog is saved* and you will not exit the dialog.

6) The sixth item is the OK dialog button.  All changes made in the Class Setup
Dialog is saved* and you then will exit this dialog.

*NOTE: When the class file is saved, any subdirectories listed in the Paths
section which have not been created will result in an inquiry as to whether you
want the subdirectories created.  You should answer YES to each inquiry about
creating a subdirectory.  However, if you know the query is the result of a
mistyped path, answer NO and correct the typing error in the affected path and
then save again.

Alternate method for creating class files (after the first one):

After entering an
existing class code and
entering your name, select
the Teacher menu and
choose the Password item. 
After entering your
Password, again select the
Teacher menu and choose
the Edit/create class item.

The Class Setup
Dialog will appear:

Make whatever 
changes need to be
made for the new
class.  Be sure to enter
a new Class Code
and, if necessary, a
new Password.

              
Save the new class

 file.

You will be asked to enter your Name; please enter your name.

Note: 
Class Code changed
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 ORIENTATION TO MICRO-ErrorChecker Plus 2006

The following pages will be a guided tour through the screens of MICRO-ErrorChecker Plus
2006.  These screens will give a general introduction to the software, but will not cover every
feature available.  The user should look at the Help screen and menu bar for commands and
options not covered in this guided tour.Start program (select Start from the Task bar then select
Programs; choose MICRO-ErrorChecker Plus 2006 or from a desktop shortcut icon).

Enter the class number of an 
existing Class Setup file.

 
Enter your name.  This must

include a complete first name
and a complete surname.  

NOTE:  The Enter Logon
Password is required
ONLY if the Logon
Password is set to YES in
the class file. (See Class
Setup dialog, item   a, 
sub-item  2,  on page 19).
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If the teacher has selected Select
Name from List in the Class Setup
Dialog, students who have previously
used the software may select their
name from a list displayed on the
screen.  If Auto Logon YES was
selected in the Class Setup Dialog
and a student's name is not on the list,
the student may add his/her name by
clicking on the Add Name button and
then type the name..

If the Password YES was selected in
the Class Setup Dialog, you will be
required to
enter your password.

Select the File menu 
and then  the Begin new
job item:

The Document preparation dialog appears;  set
the Settings and Operation mode desired:

NOTE: All document settings must be made on
this dialog before the activity begins.  Once the
activity begins, these settings CANNOT be
changed until a new activity is begun.

If Timing Method 2 is selected, the message near
the bottom of the screen indicates when the
workstation was last re-booted.  This Timing
Method requires the workstation to be re-booted
within 24 days.
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Upon clicking on the Continue
button (or striking Enter), the
activity  input screen appears. 
The first key stroke will begin
the timer.  NOTE: The status
line now contains the Operation
Mode; Page, Line, Column of
the cursor; Timer information;
Correction status; Wordwrap
status; and INSERT or
STRIKEOVER status.  The
input screen is now ready for
text entry:

TIMED WRITING:  

Type the following timed writing for 3 minutes:

This is a sample timed writing that you may practice on to test the error-checking
capabilities of Micro-ErrorChecker Software.  This timed writing is a short three paragraphs
long.

As you test the error-checking of this timed writing you may want to deliberately make
several errors to ensure that the error checker will catch the errors properly.

Remember, a timed writing must be typed in sequence beginning with the first line of the
first paragraph.  If you finish the timed writing before the time period is complete, repeat the
material starting with the first paragraph.

At the end of the timing 
period, the
Document data
dialog will appear:

Click on the Check
document for
errors button.  
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The Open KEY file
dialog box (shown above) will
appear; select the TW1 key
file for this timed writing:

 

If there are errors, the
ErrorCheck report is
displayed showing the KEY in
the upper window and the
student's TEXT in the lower
window:

If No Errors, the following is
displayed:

Upon clicking on the Exit 
ErrorCheck Report, the
following Document Data
dialog appears with the
ErrorCheck Information:

Click on the Continue button
to Begin a New Job; when
the New Job dialog box
appears, the settings should
be Timer ON, Stopwatch
OFF, Timer display ON, and
Correction ON.  The
Operational mode should be
Simplified word processor.  
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LETTER:

You will now type a simple letter; deliberately make both content errors and format errors:

Directions:  Type the following letter as a modified block letter with paragraphs indented; use
mixed punctuation.  Formatting directions: Margins should be set at 10 and 75.  Paragraphs
should be indented 5 spaces.  The current date should be typed on Line 16.

[use current date] | Ms. Jane R. Sullivan | 3945 East Thunder Ridge Court | Cedar Falls, IA
50613 | Dear Ms. Sullivan: |

Thank you for your recent inquiry about our new product line.  We are sending you our
most recent catalog published [use the last day of the previous month--for example, March 31,
1998].

If you place an order by December 31, [use current year], you will receive a 20 percent
discount [underline the words '20 percent discount') in addition to the free promotional gift
mentioned in the catalog.

To rush your order, call our toll-free number 1-800-555-3345. [Type the phone number in
bold] Operators are standing by 24 hours a day to take your order.

Sincerely, | [Use your name here] | Vice President of Marketing | [reference initials]

After you have completed the letter, End the Job by pressing ESC or the End Job item in the File
menu.  Click on the Check document for errors button and load the Letter1 key.  

If no errors found: If no content errors found: If no format errors found:

If any errors found, ErrorCheck reports for content errors and/or format errors will be
displayed.
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After viewing the 
error reports, if any,
the Document data
dialog display with all
the information in the
Current job data
summary section:

Click on the Save
document button to
save this letter.

Click on the Display
student record button
to view the student
record.

The following student record
displays Timed Writings:

NOTE:  If Correction is ON and
a student uses Copy/Paste, the
Saved As  name is preceeded by
an asterisk (*).

Click on Next Score Type until
the Production screen appears:

The following student record
displays Production activities:

When finished, click on Exit.
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OTHER MENU BAR ITEMS
1.  Simplicity Plus Menu Item:

This menu item will permit the launching of the three programs: Ten-Key Development program,
Database Data Entry Development program, and the Basic Keyboarding Tutorial program.

The teacher can control whether these three programs will be available for use by the students.  To
select whether these programs will be available, the Selection may be made from the Teacher
menu item "Set Simplicity Availability" as shown below:
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2.  Supp. Materials Menu Item:  

This "Supp. Materials" menu item allows the student to select a Supplementary Materials activity to
be displayed on the screen.  The availability of the activities may be controlled by the teacher from
the "Teacher" menu item by selecting the "Set Activities to Display":

NOTE: You can make available all, none, or selected activities to be available to the students.

See the screens on the following 2 pages of all the Supplementary Materials available for display on the
students screen.
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3.  Display Format Summaries:

The student may select which Format Summary to display.  These summaries require
that the workstation have Acrobat Reader available (all files are in pdf format):
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The availability of these format
 summaries may be set by the teacher
 from the "Teacher" menu by selecting
 the "Set Available Format
 Summaries":

4.  Displaying/Printing User Manuals from the "Teacher" menu and then selecting either the MEC
User Manual or the
Simplicity User Manual:
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5.  Display/Print Mini-Supplementary Solutions:



39

6.  Display/Print Supplementary Blackline Copies:
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7.  Teacher Data Entry Problem Creation:
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COMMANDS SUMMARY

KEY MODES OPERATION DESCRIPTION

BACKSPACE T ET WP Backspace If correction is on, removes
 character to the left of the current

cursor position, and moves cursor
one character left.  If correction is
off, cursor does not move..

BACKSPACE      WP Redisplay lines See CTRL+F8 below.  To
 redisplay the blank lines
compressed at the top of a page,
place the cursor on line 6 at the

 left margin and backspace.  To 
compress these blank lines strike
CTRL+F8.

DEL T ET WP Delete character With correction ON, removes
character at current cursor position,
and repositions text on the line to
 the right of current cursor position.

END T ET WP End of Line With correction ON, removes
 cursor to end of current line.

ESC T ET WP Escape Exits current job or activity.
HOME T ET WP Beginning of Line With correction ON, moves

 cursor to first character on
 current line.

INSERT T ET Insert character Inserts a blank space at current
 cursor position, and repositions
 text on the line to the right of

 current cursor position.
INSERT WP Insert ON/OFF With correction ON, turns insert

 mode on or off.
PAGE DOWN T ET WP End of Page With correction ON, moves

 cursor past the end of the page.
PAGE UP T ET WP Begin of Page With correction On, moves
 cursor to the first line of the current

page.
RETURN T ET WP Exit Review Exits from Review Work in

progress.  (ESC also exits from
Review Work.)

TAB T ET WP Tab Move cursor to next tab stop.
CURSOR DOWN T ET WP Cursor down Move cursor down 1 line.
CURSOR LEFT T ET WP Cursor left Move cursor 1 position left.
CURSOR LEFT T ET WP L margin release Left margin is released when 

cursor left key pressed while
 cursor is at the left margin.
CURSOR RIGHT T ET WP Cursor right Move cursor 1 position to right.
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CURSOR RIGHT T ET WP R margin release Right margin is released when
the cursor right key is pressed
with the current cursor position

 being at the right margin.
CURSOR UP T ET WP Cursor Up Move cursor up 1 line.
CTRL+A T ET WP Save job as ... Save the current job under a

different filename.
CTRL+D   ET WP Set decimal tab Direct command from typing
 screen to set a decimal tab at cursor

position.
CTRL+E T ET WP Error-check Error-check document currently
 in memory.  This key may be pressed

in the typing screen only.
CTRL+N T ET WP New job/activity End current job and begin a new

job/activity.
CTRL+T T ET WP Set regular tab Direct command from typing 

screen to set a regular tab at
 cursor position..
CTRL+END T ET WP End of document Move cursor to the end of the
 document.
CTRL+HOME T ET WP Beginning of doc With correction ON, move cursor
 to the first line of the document.
CTRL+F1 T ET WP Delete document Remove document from the
 student storage disk.  The program

will prompt the user to enter the
filename to be removed.

CTRL+F2 T ET WP Clear all tabs Remove all tab stops for the
 current line and all blank lines which

follow the current line.
CTRL+F3 T ET WP Erase copy Remove current document from
 memory and prepare to begin a new

document.
CTRL+F4 T ET WP Pica pitch Changes pitch to Pica for the current

line and all blank lines which follow.
CTRL+F5 T ET WP Elite pitch Changes pitch to Elite for the
 current line and all blank lines which

follow.
CTRL+F6 T ET WP Student record Provides access to display, print,
 or backup the student's individual

record.  This feature is available
only from the main menu.

CTRL+F7 T ET WP Delete line Removes the current line, and
 repositions subsequent lines.

CTRL+F8      WP Compress/ Any blank lines from line 6 to
decompress top lines the first line below that is not

 blank is compressedto bring first
non-blank line up to line 6or to
display all the blank line that have
have been compressed.  The number
of compressed blank lines is stored
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in theprevious "end of page" line at
the rightedge.  To redisplay the blank
lines, strike CTRL+F8 or strike BS
(backspace) at the the left margin on
line 6.

CTRL+F9 T ET WP Insert line Inserts a blank line at the current
 line position, and repositions

subsequent lines.
CTRL+F10 T ET WP Screen refresh Redisplays the current typing
 screen.
CTRL+ALT+B T ET WP Add/Delete Bold Add or remove bold character at
 current cursor position.

CTRL+ALT+E   ET WP Expand ON/OFF Turn the automatic expand
 (spread) typing on or off.
CTRL+ALT+F      WP Paragraph format Reformat the current paragraph
 using the margins, tabs, spacing, and

pitch currently shown on the status
line.

CTRL+ALT+J   ET WP R justify ON/OFF Turn the automatic right
 justification feature on or off.
CTRL+ALT+K T ET WP Superscript Turn the automatic superscript
 feature on or off.  This feature is

available only from the typing
screen.

CTRL+ALT+M   ET WP Margin center Center the text on the current line
 between the margins.  If the current

line is blank automatic centering will
be turned on.

CTRL+ALT+R      WP Find/Replace Search for specified words; may 
replace selectively or replace all.

CTRL+ALT+F9 T ET WP Save form Save the current document as a
 form.
CTRL+ALT+U   ET WP Bold & Underline With correction ON, add or
 remove underline and bold from the

character at the current cursor
position.

CTRL+SHFT+B   ET WP Bold ON/OFF Turn the automatic bold feature
 on or off.
CTRL+SHFT+C   ET WP Center ON/OFF Turn the automatic centering
 feature on or off.
CTRL+SHFT+D T ET WP Double line spacing Changes line spacing to double

spacing.
CTRL+SHFT+L T ET WP Set left margin Set the left margin at the current
 cursor position.
CTRL+SHFT+N T ET WP Next 7 lines Move the cursor down 7 lines.
CTRL+SHFT+P T ET WP Previous 7 lines Move the cursor up 7 lines.
CTRL+SHFT+R T ET WP Set right margin Set the right margin at the
 current cursor position.
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CTRL+SHFT+S T ET WP Single line spacing Changes line spacing to single
 spacing.
CTRL+SHFT+T T ET WP Triple line spacing Changes line spacing to triple space.
CTRL+SHFT+U     ET WP Underline ON/OFF Turn the automatic underline
 feature on or off.
CTRL+SHFT+W T ET WP Next word Move cursor to the first character
 of the next word.
CTRL+SHFT+X T ET WP Previous word Move cursor to the first character
 in the previous word.

SHFT+TAB T ET WP Previous tab Move the cursor to the previous
 tab stop.
SHFT+Und T ET WP Add/DeleteUnd Underscore the character at the
 current cursor position.
F1 T ET WP Display WPM rate
F2 T ET WP Clear single tab
F3 T ET WP Display timer
F4 T ET WP Next screen (Supp. Mat. display)
F5 T ET WP Load form
F6 T ET WP Print document
F7 T ET WP Load document
F8      WP Hanging indent
F9 T ET WP Save document
F10 T ET WP Command screens
F11 T ET WP Reveal spacesShow spaces that have

been typed by the student with a ^
character.

F12 T ET WP Previous screen (Supp. Mat display)

Alphabetical Listing of all key functions:

KEY FUNCTION DESCRIPTION     KEY            

Activity/job, New CTRL+N
Activity/job, Save F9
Activity/job, Save as CTRL+A
Add/Delete Bold  CTRL+ALT+B
Add/Delete Underline  SHIFT+ALT+underscore key
Add/Delete Underline & Bold CTRL+SHFT+U
All, Tabs clear  CTRL+F2
Arrow key to move cursor  UP-, DOWN-, LEFT-, RIGHT-arrow key

Beginning of document  CTRL+HOME
Beginning of line  HOME
Beginning of page  PgUP
Bold, Add/Delete  CTRL+ALT+B
Bold mode  CTRL+SHFT+B
Bold and Underline,Add/Delete  CTRL+ALT+U

Center existing line  CTRL+ALT+M
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Center mode  CTRL+SHFT+C

Character, Delete  DELETE
Character, Insert (blank space) INSERT
Check, Error  CTRL+E
Clear, All tabs  CTRL+F2

Clear, Single tab   F2
Clear memory  CTRL+F3
Command screens  F10

Compress blank lines  Ctrl+F8
Copy CTRL+C
Copy (text) in memory, Erase  CTRL+F3
Current job/activity, Print F6
Current job/activity, Save F9
Current job/activity, Save as CTRL+A
Cursor movement keys  UP-, DOWN-, LEFT-, RIGHT-arrow key
Cut CTRL+X

Decimal tab, Set CTRL+D
Delete/Add Bold  CTRL+ALT+B
Delete/Add Underline  SHFT+underscore key
Delete/Add Underline and Bold  CTRL+ALT+U
Delete character  DELETE
Delete document  CTRL+F1
Delete line  CTRL+F7
Display timer  F3
Document, Beginning of  CTRL+HOME
Document, Delete  CTRL+F1
Document, End of  CTRL+END
Document, Erase CTRL+F3
Document, Load  F7
Document, Print  F6
Document, Save  F9
Double line spacing CTRL+SHFT+D
Down, Scroll 7 lines  CTRL+SHFT+N

Elite pitch CTRL+F5
End of document  CTRL+END
End job/activity ESC
End of line  END
End of page  PgDn
Erase copy in memory  CTRL+F3
Error check  CTRL+E
Existing line, Center  CTRL+ALT+M
Expanded text  CTRL+ALT+E

Find/Replace  CTRL+ALT+R
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Form, Load  F5
Form, Save  CTRL+ALT+F9

Hanging indent  F8

Indent, Hanging  F8
Insert character (blank space)  INSERT
Insert line  CTRL+F9
Insert mode  INSERT
Initialize for student use CTRL+I

Job/activity, New CTRL+N
Job/activity, Print F6
Job/activity, Save F9
Job/activity, Save as CTRL+A

Justify, Right  CTRL+ALT+J

Left margin release <--
Left margin, Set  CTRL+SHFT+L
Line, Beginning of  HOME
Line, Center existing  CTRL+ALT+M
Line, Delete  CTRL+F7
Line, End of  END
Line, Insert  CTRL+F9
Line spacing, Double CTRL+SHFT+D
Line spacing, Single  CTRL+SHFT+S
Line spacing, Triple CTRL+SHFT+T
Load document  F7
Load form  F5

Margin, Set left  CTRL+SHFT+L
Margin, Set right  CTRL+SHFT+R
Margin release (left) <--
Margin release (right) -->
Memory, Clear document in  CTRL+F3
Minutes, Word per  F1
Mode, Bold  CTRL+SHFT+B
Mode, Centering  CTRL+SHFT+C
Mode, Insert  INSERT
Mode, Superscript  CTRL+ALT+K
Mode, Underline  CTRL+SHFT+U
Movement, Cursor  UP-, DOWN-, LEFT-, RIGHT-arrow key
Multiple activity CTRL+M

Next word  CTRL+SHFT+W
New job/activity CTRL+N
Next 7 lines (scroll down) CTRL+SHFT+N
Next Supp. Mat. display screen F4
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Page, Beginning of  PgUp
Page, Compress  CTRL+F8
Page, End of  PgDn
Paragraph, Reformat  CTRL+ALT+F
Paste CTRL+V
Pica, Elite CTRL+F5
Pitch, Pica CTRL+F4
Pica pitch CTRL+F4
Placement, Expanded text  CTRL+ALT+E
Previous 7 lines (scroll up) CTRL+SHFT+P
Previous Supp. Mat display screen F12
Previous word  CTRL+SHFT+X
Previous tab SHFT+TAB
Print document (current job/activity)  F6
Print setup CTRL+U

Rate, WPM F1
Record, Student CTRL+F6
Reformat paragraph  CTRL+ALT+F
Refresh screen  CTRL+F10
Regular tab, Set CTRL+T
Replace/Find  CTRL+ALT+R
Reveal spaces  F11
Reverse tab  SHIFT+TAB
Review work (current job) CTRL+W
Review work/ Exit RETURN or ESC
Right justify  CTRL+ALT+J
Right margin release -->
Right margin, Set  CTRL+SHFT+R

Save as (current job/activity) CTRL+A
Save document (current job/activity)  F9
Save form  CTRL+ALT+F9
Screen, Refresh  CTRL+F10
Scroll down 7 lines  CTRL+SHFT+N
Scroll up 7 lines  CTRL+SHFT+P
Set left margin  CTRL+SHFT+L
Set right margin  CTRL+SHFT+R
Set tab, Decimal CTRL+D
Set tab, Regular CTRL+T
Setup, Print CTRL+U
Single line spacing CTRL+SHFT+S
Single, Tab clear  F2
Spaces, Reveal  F11
Student record CTRL+F6
Superscript mode  CTRL+ALT+K
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Tab clear, All  CTRL+F2
Tab clear, Single  F2
Tab, Previous  SHIFT+TAB
Tab, Reverse  SHIFT+TAB
Tab set, Decimal CTRL+D
Tab set, Regular CTRL+T
Timer display  F3
Triple line spacing CTRL+SHFT+T

Underline, Add/Delete  SHIFT+underscore key
Underline and Bold, Add/Delete  CTRL+ALT+U
Underline mode  CTRL+SHFT+U
Up, Scroll 7 lines  CTRL+SHFT+P

WPM rate  F1
Word, Next  CTRL+SHFT+W
Word per minute rate  F1
Word, Previous  CTRL+SHFT+X

All of the features described above are on the COMMAND SCREENS and in the MENU
 bar

Screen 1:.

Screen 2:
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ERROR-CHECKING &KEY BUILDING PROCEDURES

WHAT DOES THE ERROR-CHECKER CHECK:

MICRO-ErrorChecker is both a content and format/style error-checker!  The software compares the
text of the student-typed document with a teacher provided key.  

The following types of content errors will be identified:

Spelling Errors Capitalization Errors
Punctuation Errors Extra Word Errors
Omitted Word Errors Transposed Word Errors
Errors in Headers Spacing errors*
Errors in Footers Underline Errors
New Line Errors Bold Errors
Broken Word Errors Superscript Errors
Run Together Words 

*Checks the horizontal spacing between words, including the appropriate number of
horizontal spaces between sentences.  

The following types of format errors for production work will be identified:  
  

Starting line Ending line
Margins Line spacing
Pitch Indentations
Horizontal centering Vertical centering
Widow lines Orphan lines
Headers Footers
Tables: Starting line on subsequent pages
   Tabs/Margins Number of blank lines between elements
   Spacing/Leaders/etc.

KEY PREPARATION    

Each document for which error-checking is required must have a key prepared.  MICRO-
ErrorChecker includes a KEY BUILDER program available from the Teacher menu.  Keys may
be created from MICRO-ErrorChecker documents, older MICRO-Typewriter documents, and
ASCII text files.  You may either type the document yourself, or may use a student's document.  It
is recommended that you use a good student's document to save time.

ENTRY TO THE KEY BUILDER PROGRAM    

The Key Builder is accessed from the Teacher menu and then choosing Key builder.  The following
screens include a step by step process for building a key for a timed writing, paragraph drill, or
line drill; the process for building a key is the same for all three types of drills.  Prior to building
a key it is necessary to have a copy of a MICRO-ErrorChecker document saved on disk.  For
this keybuilding exercise, a timed writing will be assumed; therefore, it is recommended that you
type (in Simplified Word Processing mode) and save the following as timed writing before
proceeding with the following illustration.   
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Now is the time for all good men and women to come to the aid of their country. 
You can assist in this worthy cause by being a good citizen and helping in your
community by being a volunteer in public activities.

Remember, don't ask what your country can do for you, but rather what can you
do for your country.

The timed writing should be saved as:  Timing1.

NOTE:  Additional information concerning the creation of production job and exam keys can be
found on page 53, KEY BUILDER FOR A LETTER PRODUCTION KEY).

KEY BUILDER FOR A TIMED WRITING KEY:

Teacher menu: 

Select Teacher menu and choose Password:

Enter your password: 

Again select Teacher menu and choose Key builder:

Keybuilder —  Load a Source Document:

Select MICRO-ErrorChecker Document; click
on OK and Load the MICRO-ErrorChecker
document named:   Timing1.

NOTE: This timed writing (timing1) should have
been typed using MICRO-ErrorChecker in the Simplified Word Processing mode.



51

Keybuilder —  Checking Information:

The default Key Type, when a
MICRO-ErrorChecker
Document is loaded, is Timed
writing.  

NOTE: If the document loaded
were either a Paragraph drill
or a Line drill, you would need
to select the appropriate Drill
Key Type.

The default Recording Type is:
Write to record.

NOTE:  If the key were to be an EXAM key, select EXAM--Write to record.  If the results of
an error check SHOULD NOT BE recorded in the Student Record, select Don't write to
record.  YOU WILL HAVE THE OPPORTUNITY TO CREATE ALL THREE
RECORDING TYPE KEYS.

Keybuilder —  Options and Instructions:

As a Timed writing Key Type, you
only have two Options:  Save key or
Edit text. 

If you have not proofread the document
carefully, select Edit text and proofread
and make any necessary corrections.

When ready, select Save key and click on
OK.  Save the key as Timing1.

Keybuilder —  Key saving options:

NOTE: There are 3 Recording
Types for saving keys.  You will
be given an opportunity to
create one, two, or three keys
for this document.  If you do not
wish to make an additional key,
you may select Exit Keybuilder
or Make a New Key.

Select Exit Keybuilder for this
exercise.
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You have completed the exercise to create a new timed writing key.  You may repeat this procedure for
both a Paragraph drill and a Line drill if you desire.  Be sure to create the drills and save them as
MICRO-ErrorChecker documents before using the Keybuilder to create keys.

KEY BUILDER FOR A LETTER PRODUCTION  KEY:

The following keybuilding procedures are applicable to all six (6) production types: Outline,
Table/Financial statement, Legal document, Manuscript (report), Letter, and Memo.  The
Table/Financial statement and any other document that contains a Table or Business Form
require additional keybuilding functions--these will be explained at the appropriate place during
this production keybuilding procedure.  Type the following as a letter in MICRO-ErrorChecker
(Simplified Word Processing mode).

Directions:

Modified block letter with paragraphs indented
Pica pitch
Margins: 10 and 75
Paragraphs indented 5 spaces
Dateline on Line 16

[use current date] | Mr. John Q. Public | 257 West Broadway | Salt Lake City, UT 84101 | 
Dear Mr. Public: |

Thank you for your recent inquiry about our new product line.  We are sending you
our most recent catalog published on May 31, [use current year].

If you place an order by December 31, [use current year], you will receive a 20
percent discount in addition to the free promotional gift mentioned in the catalog.

To rush your order, call our toll-free number 1-800-555-3345. [Type the phone number
in bold] Operators are standing by 24 hours a day to take your order.

Sincerely, | [Use your name here] | Vice President of Marketing | [reference initials]

The Letter should be saved as: Letter.
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KEY BUILDER FOR A LETTER PRODUCTION KEY:

Follow the same initial procedures as when you created the timing1 key.

Teacher menu: 

Select Teacher menu and
choose Key builder (or choose
Password if Key builder item
is inactive and enter your
password).

Keybuilder —  Load a Source Document:

Select MICRO-ErrorChecker Document; click on
OK and Load the MICRO-ErrorChecker document
named:   Letter.

NOTE: This production document (letter) should
have been typed using MICRO-ErrorChecker in the
Simplified Word Processing mode.

Keybuilder —  Checking Information:

The default Key Type, when a
MICRO-ErrorChecker Document is
loaded, is Timed writing.  Since this
document is a letter, select the Key
Type as: Letter.
The default Recording Type is:
Write to record.

NOTE:  If the key were to be an EXAM key, select EXAM--Write to record.  If the results of
an error check SHOULD NOT BE recorded in the Student Record, select Don't write to
record.  YOU WILL HAVE THE OPPORTUNITY TO CREATE ALL THREE
RECORDING TYPE KEYS.
NOTE: At this point in the exercise, ignore the other Production sections (Production --
Headers/Footers and Production —  Document Settings); these sections will be covered in
detail in DOCUMENT SETTINGS FOR FORMAT CHECKER on page 60.
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Keybuilder —  Options and Instructions:

As a Letter Key Type, you have several
Options available. 

Edit text--if you have not proofread the
document carefully, select Edit text and
proofread and make any necessary
corrections.

Mark VARIABLE text--if you have
any items in the document that may be
done differently by your students (i.e.
current date, reference initials, using their own name in the closing, or using only the current
year), you will have the opportunity to mark these areas and replace them with bracket
commands that the error checker recognizes in order to not mark errors that should not be
marked.  Select Mark VARIABLE text and mark the required areas.

Instructions: 
1. Left click mouse and hold mouse button down on the starting character of the variable

to be marked.
2. While holding left mouse button down, move cursor to last character in the variable

being marked.
3. Release the left mouse button and you will be taken directly to the Keybuilder —

Bracket commands dialog for selection.

Keybuilder —  Bracket commands
(Mark VARIABLE text):

If you have marked the current date
at the top of the letter, select the
[date] bracket command and then
click on Insert Bracket Command
button.
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       Mark Variable text to mark another item.  Mark the year 1998 and press ESC.  Select the [year]
bracket command and then click on Insert Bracket Command button.

Select Mark Variable text to mark another year 1998.  Select the [year] bracket
command and then click on Insert Bracket Command button.

Select Mark Variable text to mark
the signer's name.  After marking
the signer's name; select the
[variable^m^n] bracket command;
selection of this bracket command
requires additional input for the m
and n variables in the bracket
command.  Set the m  variable to 1
and the n variable to 6.  This means
that the marked area will permit
any input from 1 word to 6 words. 
The content of this marked area
WILL NOT be error checked.  

Click on Insert Bracket Command button. 

NOTE: If you were to select (page numbers) [pnum^x], (digits) [d^m^n], (letters)
[l^m^n], you will be required to provide the x or m and n parameters.  If you select
[pnum^x] bracket command, you will also be required to indicate whether the page
numbers should be Arabic or ROMAN numerals.

Select Mark Variable text to mark the reference initials.  Select the [ref] bracket command
and click on the Insert Bracket Command.

Since your have completed all variable items, you are now at the Keybuilder-Options and
Instructions dialog.

NOTE:  This letter does not have the following items active:  Create/Edit sample
HEADER, Create/Edit sample FOOTER, and Mark text for BUSINESS FORMS
AREAS.  These items are inactive because the document is only a one-page letter and it
does not contain a business form.  Since we know the letter does not contain any columnar
or table areas, we do not need to select this item.  All four of these items will be discussed
in the SPECIAL ERRORCHECKER INSTRUCTIONS section on page 63.

ATTENTION: To cancel any line-by-line marking for Mark text for
MULTIPLE SPACING check, Mark text for LINE-BY-LINE check,
Mark text for HORIZONTAL CENTERING, Mark text for
COLUMN/TABLES AREAS, and Mark text for BUSINESS FORM
AREAS.  Select the appropriate "unmark" button and click inside the
marked area.

The ESC key is used to return from the text area to the previous dialog
box.
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The Mark text for MULTIPLE SPACING check option will not be used for this letter
key.  This option is used only when the spacing between words (elements) is to be ignored
and not checked.  Lines which contain tabular items which may have variable inter-word
(inter-element) spacing should be marked for Multiple Spacing.

Select the Mark text for LINE-BY-LINE check.  A single line or any group of contiguous
lines that should be checked a line at a time should be marked for line-by-line checking. 
Mark the area from the dateline down through the salutation as a single block to be checked
line-by-line.  Also mark the area from Sincerely down through reference initials as a
second block to be checked line-by-line.

The letter contains no lines which should be centered horizontally between the margins;
therefore, the option Mark text for HORIZONTAL CENTERING is not used in this
letter key.

All options for this letter have been completed; select Save key and click on OK.  

Keybuilder —  Variable
Vertical Spacing:

There are some production
documents which may have
the number of blank lines
between some elements that
can have a variable number of
blank lines acceptable. 
Therefore, if you would like to
permit, for example, 2 - 5
blank lines between Sincerely
and the Signer's name, you would select YES.  If there should be no areas which would
allow for a variable number of blanks lines, select NO.

Select YES for this
example.

After every hard return in
the document, the
variation between
paragraphs dialog
appears for your decision.
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Keybuilder —  Variation Between Paragraphs:

For all the items from the dateline to Sincerely, you should click on Follow Key Spacing.

When you see the dialog box that contains Sincerely and [variable^1^1], select A
limited range required and set the first parameter to 2 and the second parameter to 5. 
This will allow a variation of from 2 blank lines to 5 blank lines between Sincerely and
the (signer's name) [variable^2^5].

NOTE: If this were a multi-page document and one paragraph ended at the bottom of one page
and the next paragraph began at
the top of the next page and if a
student set the margins different
than the key, these two paragraphs
might be end and start on the same
page; therefore, the keybuilder
needs to know how many blank
lines should be between the
paragraphs/elements if these two
paragraphs/elements end and start
on the same page.  If  the
keybuilder discovers this situation, you will see the following Keybuilder --Blank Lines Between
Paragraphs dialog.

Keybuilder --Blank Lines Between Paragraphs

Set the number of blank lines to 1.

Click on Record in Key button.

When all of the variable vertical spacing areas have been queried, you will see the Save Key
dialog appear.  Save the key as:  Letter.

When you see the Keybuilder —  Key saving options dialog, you may save all three
Recording Types of keys.  After saving the key(s), click on Exit Keybuilder button to
conclude this exercise.
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KEY/DOCUMENT TYPE DEFINITIONS
   

The Keybuilder —  Checking Information dialog allows the instructor to set Key Type,
Recording Type, and for production jobs set whether headers or footers will be needed for the key
being created.

HEADERS AND FOOTERS

These two options appear only if the Key Type has been set for a Production document (anything
other than a Timed writing, Paragraph drill or a Line drill.)  If the second and subsequent pages of
the document will include a heading (even if it is just a page number) or if all the pages will include
a footer (again, even if it is just a page number) the option should be selected and checked.  If
either of these items are selected, it will be necessary to create a sample header or footer.  An
option to Create/Edit a sample HEADER and/or Create/Edit a sample FOOTER will be
activated in the Options section of the Keybuilder -- Options and Instructions dialog. 
REMEMBER:  Once a sample header or footer has been created, it will also be necessary to
remove the actual headers and/or footers from the key document (use the Edit text option).

DOCUMENT TYPE DEFINITIONS

Timed Writings and Drills

TIMED WRITING:

A timed writing consisting of one or more paragraphs that must be typed in sequence beginning
with the first paragraph.  If the timed writing consists of more that one paragraph, the paragraphs
cannot be typed out of sequence.  However, if the entire timed writing has been completely typed,
the student may return to the first paragraph and repeat the entire timed writing more than once.

PARAGRAPH DRILL:

A paragraph drill consist of one or more paragraphs that may be typed independently of each other
(even in a repetitive manner--a single paragraph may be typed more than once.)  If the paragraph
drill contains more than one paragraph, any combination of paragraphs may be typed in any order
and any number of times.  This is different than a timed writing which must be typed in sequence.

LINE DRILL:  

A line drill consist of several drill lines.  Each drill line must be a single line and generally ends
with some type of punctuation mark.  Drill lines are error checked one line at a time; therefore,
wordwrap should not be used for Line Drills.  Line drill error-checking allows any combination of
lines to be typed in any order.
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Production Exercises

Production exercises will be checked for both content and format.  The following Key Types are
available for error-checking:

OUTLINE:

The horizontal spacing must match the horizontal spacing in the key.  May contain headers and/or
footers.

TABLE/FINANCIAL STATEMENT:  

Automatically uses multiple spacing check for content errors.  May contain headers and/or footers. 
The format checker will check the number of spaces between columns, use of leaders, etc..  

LEGAL DOCUMENT:

May contain headers, footers, tables, etc.

MANUSCRIPT:

May contain headers, footers, tables, etc.  If you are ever in doubt as to what type of key to use,
this is the one.

LETTER:

May contain headers, footers, tables, etc.

MEMO:

May contain headers, footers, tables, etc.

RECORDING TYPE DEFINITIONS
Write to record:

Keys of this type will write the results of the error-check to standard areas (timed writing,
paragraph drill, line drill, or production) of the student's record.  

EXAM--Write to record:

Keys of this type will write the results of the error-check to the exam portion of the student's
record.  Exams in the student record may be sorted several different ways, with averages computed
if the exams are sorted for a selected date.

Don't write to record:

Keys of this type will NOT write the results of the error-check to the student record.
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DOCUMENT SETTINGS FOR FORMAT CHECKER
   
NOTE TO PREVIOUS ERROR-CHECKER USERS:  

All error-checking keys that you have prepared with Version 8 will work with Version 2006 of
MICRO-ErrorChecker Plus 2006.  However, any production keys previously made on versions
earlier than Version 7 will ONLY CHECK for content errors until you rebuild the key using the
Keybuilder in Version 2006 (or Version 8) and setting the required format checking features.

  
NOTE:  The old keys for Line drills, Paragraph drills, and Timed writings DO NOT need to be
rebuilt with Version 2006.

 
IMPORTANT CAUTION:  Any keys rebuilt with Version 8 or Version 2006 WILL NOT work
with versions 7 or earlier version of the MICRO-ErrorChecker; therefore, if you will ever have a
need to use your old keys with a version earlier than version 8 of MICRO-ErrorChecker, you
should make backup copies before rebuilding the old keys.

Keybuilder —  Checking Information:

The Production sections (Production —
Pitch, Production —  Headers/Footers,
and Production —  Document Settings) are
active only if the Key Type is set for one of
the production types.

Production —  Pitch defaults to either
PICA or
ELITE,
depending on
how the pitch
was set in the original MICRO-
ErrorChecker document.  The pitch can
only be changed if the Source Type is: ASCII Text File.

Production —  Headers/Footers:

If the document requires either headers or footers to be typed, the appropriate box must
be checked.  NOTE: Generally, a document will have only headers or footers, not both!

 
The basic format checking will be done according to the original format of the document from
which the key is created.  Be sure that the document from which the key is to be created is accurate
in terms of its formatting.  The key builder will scan the key document to determine spacing,
margins, etc. 

NOTE: The active items in the Production —  Document Settings section will vary depending
on the production Key Type selected.

The  format checker will provide for the variations and/or tolerances as selected above.  A brief
description for each item in the Production —  Document Settings section above will now be
given:
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Check for Widow and Orphan lines:  

If this box is checked, the document will be checked for a single paragraph line at the bottom and
top of pages.  The first line of a paragraph that is isolated at the bottom of a page is referred to as
a widow line and will be marked as a format error.  Likewise, if the last line of a paragraph is
isolated at the top of a page, this is referred to as an orphan line and will be marked as a format
error.  If you do not wish widow/orphan lines to be marked as format errors, do not check this
box.

Margin tolerance allowed:  

If you are willing to accept margin settings different from the margins set in the key document, you
may set the margin tolerance from 1 to 15 spaces (plus or minus) from the margins set in the key
document.  NOTE:  The checking of margins will be done only when the margins of the student's
document indicates that the margins have been changed; otherwise, the checking of margins will
only be done once for the first line of the document being checked.  NOTE: If the key contains a
business form that contains columns and the specific tab settings are not specified, you must set
the margin tolerance allowed to provided sufficient variation to accommodate a reasonable
starting position of any marked non-columnar line.

Indention tolerance allowed:

If you are willing to accept the size of the indentation to be different from the key document, you
may set the indention tolerance from 1 to 15 spaces (plus or minus) from the first indention in the
key document.  NOTE:  The checking of indentations will be done the first time an indentation
occurs in the student's document.  Once an indentation is identified as being acceptable within the
indention tolerance range, all subsequent indentations will be required to be the same for
consistency of appearance.

First line page 1:  

You may set the starting line for page 1 to fall within a range or accept ANY.  If the starting line
for page 1 is less than or greater than the range, this will result in a format error.

First line on subsequent pages (excluding header): 

Defaults to line 6.
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Last line for text on each page (excluding footer):  

If you desire that the last line of each page (except the last page) be keyed within a certain range
(usually from line 55 to 60), you may specify that range or you may set it to ANY.  NOTE: If any
multiple-page document requires a page--located before the last page--to end high on the page,
the Last line for text on each page (excluding footer) should be set to ANY to avoid a format
error.

Header lines (lines 1-5):  

If headers are used in the document, you must designate that the headers be within a certain range. 
When the range is set, the entire header must begin and end within this range or a format error will
result.

Footer lines (lines 61-65):  

If footers are used in the document, you must designate that the footers be within a certain range. 
When the range is set, the entire footer must begin and end within this range or a format error will
result.
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SPECIAL ERRORCHECKER INSTRUCTIONS
   

      

The
Options section of The Keybuilder -- Options and Instructions dialog allows the teacher to
customize the error-checking of each document.  A description of each item follows.  

Save key:

This option will save the completed key to the path specified when the class file was created for
this class.  The key must be saved before beginning a new key or exiting the Keybuilder
program.  The instructor could change this path (at the Save Key dialog) if he or she wanted to
put the files on a floppy disk to give to an instructor or to another school which was licensed to
use MICRO-ErrorChecker Plus 2006.  The software defaults the file name to the name of the
source document.  Obviously, this name may be changed at the Save Key dialog.  This
filename must not include a period in the filename since the software will automatically add the
extension '.~ky' for the key file and '.~ms' for the master file.  NOTE: If you have loaded the
document named Report1 and have selected the Recording Type as EXAM--Write to record,
the software will automatically modify the filename as to reflect the Recording Type as:
Report1_EX. Likewise, if the Recording Type were Don't write to record, the filename for
the saved key would be: Report1_NO
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. NOTE: If a business form is detected in the key, you will get the following reminder dialog:

Business form in key:

If you have already marked the
business form, click on
Continue and proceed. 
However, if you had forgotten
either to Mark FIRST/NEXT
form area and/or Mark
LINE-BY-LINE, clicking on
the appropriate button will
take you directly to the next
step to accomplish this task.

For example, click on the Go to Mark FIRST/NEXT form area button and the following
appears:

Keybuilder —  Business Form
Marking Options:

Select the Mark FIRST or NEXT
form area option.

Click on Mark button.

After you have marked all of the First
and/or Next form areas, strike ESC to
go to the next dialog: 

Keybuilder —  Specific
Columnar Settings:

You will have the opportunity
to set intercolumn tolerances
that permit variance from the
key the set number of spaces
indicated here.

The first column tolerance
permits the starting of the first
column (or left edge of the
form) to be set at + or --
number of spaces in variation
from the key.
Be sure to Mark NONCOLUMNAR lines of form area.  When you have completed the
marking in the Keybuilder —  Business Form Marking Options dialog, click on the Marking
Finished button which will return you to the Keybuilder —  Options and Instructions dialog.
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At this point, you have the opportunity to mark the business form for line-by-line checking if
you have not already done so.  After completion of marking the business form, select the Save
key option and click on the OK button.  You will again have the Keybuilder —  Business
Form in Key dialog appear.  This time you should click on the Continue button to complete
the saving of this key.

Variable Vertical Spacing:

When saving a production job key, you will be provided with the opportunity to provide
variable vertical spacing (the number of blank lines allowed between elements in the key).  If
there are any such places between paragraphs or other elements where you would permit a
variation in the number of blank lines, select the YES button.  For example in a letter, you may
allow from 2 to 5 blank lines in the space where the signer places his or her signature.  Also, if
you have a multi-page document and a paragraph or other element ends at the bottom of one
page in the key and a new paragraph or the next element begins at the top of the next page in
the key, you will need to select the YES button and provide information about how many blank
lines you will allow if the last line of the first paragraph/element and the first line of the next
paragraph/element happen to end up in the student's document on the same page (this can
happen if the student's margin settings are not the same as the margins settings in the key!)  The
number of blanks lines may be only 1, but the format error-checker need to know!

Keybuilder —  Variable Vertical
Spacing:

Click on the NO button to skip the
Variable Vertical Spacing option.

Click on the YES button to select the
Variable Vertical Spacing option for
this exercise..

The software will search through the key document and locate every hard return which provides
the place where a decision on the number of blank lines will be made.  The following dialog
appears: 

 
Keybuilder —  Variation        

      Between Paragraphs:

This dialog appears each time
for your decision.

Whenever this dialog box appears, you make the decision whether to allow a variable number
of blank lines between the two paragraphs/elements.  If the decision is NO variation to be
allowed, click on the Follow Key Spacing button.  The software will continue it search for the
next logical location for a decision.
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If your decision to to allow a variable number of blank lines between the two
paragraphs/elements, select either Any number of blank lines acceptable or A limited range
required.  If you select the first option, after checking the box, click on the Record Variation
in Key button.  However, if you select the second option, after checking the box, indicate what
the two parameters will be (from x to y number of lines allowed); then click on the Record
Variation in Key button.

If the software finds a paragraph or element that ends at the bottom of a page and the next
paragraph or element begins at the top of the next page, you will see the following dialog box
appear.

Keybuilder —  Blank Lines Between Paragraphs:

A decision on the number of blank lines is required.  The format error-checker must know
how many lines will be permitted if both elements are found on the same page.  Your options
are to select ANY or a
number between 1 and 9.  For
normal line spacing between
paragraphs, the default of 1
line should be accepted. 
When ready, click on Record
in Key button.

When all decisions have been
made, the software will take
you directly to the Save Key
dialog box.  Unless you must
change the filename or the storage location (path), all you need to is click on the Save button
and both the Key file and the Master file will be saved.

Saving other Recording Types of Key files and Master files:

We recommend that you save all three types of Key and Master files at the same time.  This
procedures will save significant time in the preparation of EXAM-Write to record keys and
Don't write to record keys.  The reason for having a REGULAR key and an EXAM-Write
to record key prepared is that the student record keeps track of all activities in two different
location in the student record; one location is for regular production work and the other
location is for examinations.  The third Recording Type (Don't write to record) is for an
activity that you do not want the results recorded in the student record.

RECOMMENDATION: In order to maintain control over which error-checking keys are
available to the students on any given day, you may want to save each Recording Type in a
separate subdirectory/folder.  To give you a reminder to change the path at the Save Key dialog
box, a reminder message is displayed if you click on the Save Key Different Path button.

For example, you may want to create the following subdirectories/folders:  

C:\Program Files\MECPlus2006Setup\keys_EX\
C:\Program Files\MECPlusSetup\keys_NO\
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After each Recording Type of key
and master is saved, the following dialog
box appears to give you and opportunity
to save the same key as a different
Recording Type with a minimum of
effort:

Keybuilder —  Key
Saving Options:

You will receive
this reminder if
you click on the
Save Key
Different Path
button.

Edit text:

Use this option to edit the text of a document.  It is recommended that the key document text be
edited so that no line ends with a non-required hyphen (this will allow students to hyphenate
words at the end of a line without an error being generated.)

Mark VARIABLE text:

Use this option to designate text that may change from student to student but yet should be
marked correct.  Such variable items include date, reference initials, year, and personal
names.  The directions for marking variable text appear in the Keybuilder -- Options and
Instructions dialog and in the Keybuilder -- Bracket commands dialog.

The following types of variable text are available, and are shown with an example:

[date] A full legal date must appear at this location 
ORIGINAL TEXT: "...on March 25, 1995 you..."
MARKED TEXT:   "... on [date] you..."

[shortdate] A date without a year must appear at this location.
ORIGINAL TEXT: "...on March 25 you ..."
MARKED TEXT:   "...on [shortdate] you..."    
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[anydate] A date allowed by either [date] or [shortdate] will be acceptable at this
location (i.e. a date with or without a year.)
ORIGINAL TEXT: "...on March 25 you ..."
MARKED TEXT:   "...on [anydate] you..."    

[pnum^x] A page number appears here.  Roman or Arabic numerals may be used. 
The x is replaced by the page number of the first page of the document
(most often 1.)
ORIGINAL TEXT: "This is page 3 of this..."
MARKED TEXT:   "This is page [pnum^1} of..."

[ref] Reference initials must appear at this location.  
(i.e. SEW, SEW:rss, PM/rs, etc.)
ORIGINAL TEXT: "SEW:rss"
MARKED TEXT:   "[ref]"

[variable^m^n] Variable text consisting of a minimum of m words and a maximum of n
words must appear here.  The text the student types at this location is
limited to a maximum of 20 words or 80 characters, whichever comes
first, and a punctuation mark counts as a separate word.  If a student was
to type their own name as part of the signature block, an appropriate
variable marking would be [variable^2^7].  The minimum number
ofwords was set at 2 so that they must include both a first and last name,

 and the maximum number of words was set at 7 just in case John M.
Brown, Jr. is in the class (four actual words in John's name and three
punctuation marks.)

CAUTION:  DO NOT use two adjacent [variable^m^n] markings in
either vertical or horizontal placement.  If you want a student to type
their own address as the return address, an appropriate variable
marking would be [variable^4^20].  The minimum number of words was
set at 4 so that the student must include at least a street name, city,
state, and zip; and the maximum number of words was set at 20 to allow
the maximum number of words possible.  A single variable marking is
used even through the street address and the city, state, and zip will be
on separate lines.

ORIGINAL TEXT: "...name is John M. Brown, Jr."
MARKED TEXT:   "...name is [variable^2^7]"

[d^m^n] Variable text consisting of a minimum of m digits and a maximum of n
digits must appear at this location.
ORIGINAL TEXT: "...I will be 17 years old..."
MARKED TEXT:   "...I will be [d^1^3] years..."

[year] A 4-digit number beginning with 19 or 20 must appear a
this location.
ORIGINAL TEXT: "...I will retire in 2018."
MARKED TEXT:   "...I will retire in [year]."
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[l^m^n] Variable text consisting of a minimum of m alphabetic characters and a
maximum of n alphabetic characters must appear at this location.
ORIGINAL TEXT: "My first name is Royce."
MARKED TEXT:   "My first name is [l^1^20]."

Create/Edit Sample HEADER:

This option will allow the creation or editing of a sample header that will appear on the second
and all subsequent pages.  The header may be on one, two, or three lines.  Your may select
from four options.

     Keybuilder —  Sample Header:

Be sure to read the Instructions
section of this dialog box for each
type of header selected.

Select the One-line spread
header and click on OK.

One of the following Enter
sample header dialog boxes
appears for the single-line spread
header:

This dialog box will appear
for the Production Key
Types of Manuscripts,
Outlines, and Tables:

This dialog box will appear
for the Production Key
Types of Letters and
Memos:
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This dialog box will
appear for the
Production Key Type
of  Legal:

Enter the three elements of a single-line spread header:

1.  At the left margin usually a name or document title. 
2. At the center point, the page number.
3. At the right margin, the date.

For this exercise, click on the Change Header Type button and select Multi-line header and
click on the OK button..

One of the following Enter sample header dialog boxes will appear for the multi-line header:

This dialog box will
appear for the
Production Key Types
of Manuscripts,
Outlines, and Tables:

This dialog box will
appear for the
Production Key Types
of Letters and Memos:
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This dialog box will
appear for the
Production Key Type
of  Legal:

Enter the three elements of a multi-line spread header:
1. At the left margin on the first line, a name or document title. 
2. At the left margin on the second line, the page number.
3. At the left margin on the third line, the date.

For this exercise, click on the Change Header Type button and select Only the page
number placed at center of line and click on the OK button..

For this exercise, click on the Change Header Type button and select Only the page
number at the right margin and click on the OK button..

NOTE: Legal documents generally do not have headers; they usually
 have footers.
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NOTE:  Once the sample header has been created, the actual headers must be removed from
the key source document.  Removal of the actual headers from the key allows the student's
pages to break at a location different from the page break in the key without generating an
error.

Create/Edit Sample FOOTER:

This option will allow the create or editing of a sample footer that will appear on the bottom of
all pages.  Please review the information in Create/Edit Sampel HEADER for more
information.  The procedures and similar; only the actual dialog boxes will refer to "footer"
instead of "header."

Mark text of MULTIPLE SPACING check:

Use this option to designate text that may have a variable number of spaces between words,
such as a table or financial statement.  This feature is automatically set for keys designated as
TABLE/FINANCIAL STATEMENT; you will only need to mark text for a multiple spacing
check in other types of keys, such as letters, memos, and manuscripts, that include tabular
material in the document.  CAUTION:  marking text for multiple spacing check should be
done after all editing of the document is complete (creation of sample headers and footers,
removing the actual headers and footers, marking text for variable checking, etc.)  If the key
is edited in any way after the document is marked for multiple spacing checking, it will be
necessary to recheck the markings.

To mark text for multiple spacing checking:

1. Left click mouse and hold mouse button down on the starting line of the area to be
marked.  (You may be at any column on that line.)

2. While holding left mouse button down, move cursor to the last line of the area to be
marked.  (You may be at any column on that line.) 

3. Release left mouse button and the area will be marked for multiple spacing.

If  there are additional blocks of text that should be checked using multiple spacing
checking, they may be marked by repeating the above steps.  To Unmark any block of text,
click on the Unmark radio button and follow the directions on the screen.

NOTE:  Mark the largest contiguous block of text that is applicable rather than mark
smaller adjacent blocks of text independently.

Mark text for LINE-BY-LINE check:

Use this option to designate text that should be checked line-by-line.  Examples that should be
checked line-by-line are:  dateline, inside address, salutation, closing, reference initials, and
closing notations of a letter;  headings, subheadings, and tables in manuscripts and legal
documents; etc.  In general, any text that should not be wordwrapped differently that it appears
in the key.

NOTE:  Mark the largest contiguous block of text possible.  For example, in a letter the
dateline, address, and salutation would all be marked as one block rather than three
separate blocks.  (The blank lines between the elements are included in the marking.
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CAUTION:  Marking text for line-by-line checking should be done after all editing of the
document is complete (creation of sample headers and footers, removing the actual
headers and footers, marking text for variable checking, etc.)  If the key is edited in any
way after the document is marked for line-by-line checking, it will be necessary to recheck
the markings.

To mark text for line-by-line checking:

1. Left click mouse and hold mouse button down on the starting line of the area to be
marked.  (You may be at any column on that line.)

2. While holding left mouse button down, move cursor to the last line of the area to be
marked.  (You may be at any column on that line.) 

3. Release left mouse button and the area will be marked for line-by-line checking.

If  there are additional blocks of text that should be checked using line-by-line checking, they
may be marked by repeating the above steps.  To Unmark any block of text, click on the
Unmark radio button and follow the directions on the screen.

Mark text for HORIZONTAL CENTERING:

Use this option to desisgnate text line(s) that should be checked for horizontal centering
between the margins.

NOTE:  Mark the largest contiguous block of text possible.  For example, in a multiple
line centered heading, all of the lines should be marked as one block rather than each line
separately.  (The blank lines between the centered lines are included in the marking.)

CAUTION:  Marking text lines for horizontal centering should be done after all
editing of the document is complete (creation of sample headers and footers, removing
the actual headers and footers, marking text for variable checking, etc.)  If the key is
edited in any way after the document is marked for horizontal centering, it will be
necessary to recheck the markings.

To mark text lines for horizontal centering:

1. Left click mouse and hold mouse button down on the starting line of the area to be
marked.  (You may be at any column on that line.)

2. While holding left mouse button down, move cursor to the last line of the area to be
marked.  (You may be at any column on that line.) 

3. Release left mouse button and the area will be marked for horizontal centering.

If  there are additional blocks of text that should be checked for horizontal centering, they may be
marked by repeating the above steps.  To Unmark any block of text, click on the Unmark radio
button and follow the directions on the screen.

IMPORTANT:  Do not use this marking feature to mark centered headings in
tables/financial statements; use the Mark text for COLUMN/TABLE AREAS.
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Mark text for COLUMN/TABLE AREAS:

Use this option to mark all areas of the table.  These markings allow the format checker to
know where specific table areas begin and end.

Keybuilder —  Table Marking Options:

Select each of the
five Options in the
order presented and
mark the
appropriate part of
the table according
to each of the five
Options.

To mark text lines for each of the five Options::

1. Left click mouse and hold mouse button down on the starting line of the area to be
marked.  (You may be at any column on that line.)

2. While holding left mouse button down, move cursor to the last line of the area to be
marked.  (You may be at any column on that line.) 

3. Release left mouse button and the area will be marked the respective option.

If  there are additional blocks of text that should be marked, they may be marked by
repeating the above steps.  To Unmark any block of text, click on the Unmark radio button
and follow the directions on the screen.

After Mark ENTIRE table
has been completed, the
following Keybuilder —
Specific Columnar Settings
appears to give you the
opportunity to designate the
intercolumn spacing
tolerances allowed (if any)
between columns, set whether
leaders (and type of leaders)
are to be used in a table, and
the tolerance for the starting
point for the first column of
the table.



75

1. Set INTERCOLUMN tolerances:  If you check this box, you will be permitted to
set a tolerance from minus 0-9 spaces to a plus 0-9 spaces from the intercolumn
spacing set in the key document or you may set ANY to allow for any number. 
REMEMBER:  The format checker requires a minimum of 3

 spaces between columns.

2. Set LEADER status:  If leaders are included in the key document, you must
designate that leaders will be used.  You will also be given the opportunity to
designate the type of leaders used: OPEN, CLOSED, or EITHER.

3. Set FIRST COLUMN tolerance:  If you check this box, you will be permitted to
set a tolerance from 1-9 spaces (plus or minus) from the starting point of the first
column in the key document or you may set ANY to allow for any starting point. 
(You may be at any position on that first line.)

Mark all CENTERED headings:
 

Use this option to mark all horizontally centered headings in the table.

To mark lines to be centered horizontally over the table:

1. Left click mouse and hold mouse button down on the starting line of the area to be
marked.  (You may be at any column on that line.)

2. While holding left mouse button down, move cursor to the last line of the area to be
marked.  (You may be at any column on that line.) 

3. Release left mouse button and the area will be marked for centered headings..

If  there are additional blocks of text that should be checked for centered headings, they may
be marked by repeating the above steps.  To Unmark any block of text, click on the
Unmark radio button and follow the directions on the screen.

Mark NON-COLUMNAR lines (includes Braced Heading Lines):

Use this option to mark all non-columnar and braced heading lines in the table.  Any line that
should not be checked as a columnar line (for example, headings within the body of the table--
like the headings in a balance sheet:  ASSETS, LIABILITIES, CAPITAL.

NOTE:  If braced headings or non-columnar lines are marked within the table, DO NOT
set any tolerances.  If you have already set column or intercolumn tolerances, you should go
back to 1) Mark ENTIRE table and uncheck the boxes for tolerances.  CAUTION: Mark
any braced heading/non-columnar/horizontal ruling lines in a column heading area
and/or body area before marking the column heading area and/or body area.

Mark ONLY COLUMN headings:  

Use this option to mark the column heading area of the table.  The format checker uses this
marking to determine if the tabs have been set properly.
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To mark the column heading area of the table:

1. Left click mouse and hold mouse button down on the starting line of the area to be
marked.  (You may be at any column on that line.)

2. While holding left mouse button down, move cursor to the last line of the area to be
marked.  (You may be at any column on that line.) 

3. Release left mouse button and the area will be marked for column headings.

If  there are additional blocks of text that should be checked for column headings, they may
be marked by repeating the above steps.  To Unmark any block of text, click on the
Unmark radio button and follow the directions on the screen.

Mark ONLY BODY of table:  

Use this option to mark the body area of the table.  The format checker uses this marking to
determine if the columns are starting at the proper place. 

To mark the body of the table:

1. Left click mouse and hold mouse button down on the starting line of the area to be
marked.  (You may be at any column on that line.)

2. While holding left mouse button down, move cursor to the last line of the area to be
marked.  (You may be at any column on that line.) 

3. Release left mouse button and the area will be marked for the body of the table.

If  there are additional blocks of text that should be checked for body of table, they may be
marked by repeating the above steps.  To Unmark any block of text, click on the Unmark
radio button and follow the directions on the screen.

Mark text for BUSINESS FORM AREAS:

Use this option to mark all areas of the business form.  These markings allow the format
checker to know where specific business form areas begin and end.

Keybuilder —  Business Form Marking Options:
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Special Information for Marking Business Forms

Business forms that are checked line-by-line (exceptions include the memo form and any
business form that allows INSERT mode/wordwrap features) usually are setup in
columnar form (examples include invoices and purchase orders).  Usually the top part of a
form (invoices, purchase orders, etc) may be recognized as being setup in columnar form;
therefore, the top part of the form should be marked as a separate form area.

1. Set INTERCOLUMN tolerances:  If you check this box, you will be permitted to set a
tolerance from minus 0-9 spaces to a plus 0-9 spaces from the intercolumn spacing set in
the key document or you may set ANY to allow for any number.  REMEMBER:  The
format checker requires a minimum of 3 spaces between columns.

2. Set FIRST COLUMN tolerance:  If you check this box, you will be permitted to set a
tolerance from 1-9 spaces (plus or minus) from the starting point of the first column in
the key document or you may set ANY to allow for any starting point.

Example of an Invoice form areas:*

*If specific tab positions for each column in the form are not required, the key
should have sufficient tolerances set for margin tolerance and Intercolumn
tolerances and First column tolerance.

To mark the entire table or each form area:

1. Left click mouse and hold mouse button down on the starting line of the area to be
marked.  (You may be at any column on that line.)

2. While holding left mouse button down, move cursor to the last line of the area to be
marked.  (You may be at any column on that line.) 

3. Release left mouse button and the area will be marked for the entire table or form area
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If  there are additional blocks of text that should be checked for the entire table or form area,
they may be marked by repeating the above steps.  To Unmark any block of text, click on
the Unmark radio button and follow the directions on the screen.

After Mark FIRST or
NEXT form area has been
completed, the following
Keybuilder —  Specific
Columnar Settings appears
to give you the opportunity to
designate the intercolumn
spacing tolerances allowed (if
any) between columns and the
tolerance for the starting point
for the first column of the
form.
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KEY BUILDING PROCEDURE
   
The following list of steps provide a guide for creating and verifying keys.

1. Obtain a source document--preferably a MICRO-ErrorChecker Plus 2006 or version 8
document .  (Use a student's document or type the document yourself.)

2. Make certain that a copy of this source document has been saved on the storage disk.  (It
will be necessary to reload the document later when you are in the Key builder program.)

3. Access the Key builder  program from the Teacher menu and load the source document. 
(Remember the Teacher menu is accessed first entering your password and then select the
Teacher menu again and choose Key builder. 

4. Do appropriate editing, marking, etc. of the source document.  

5. Save the KEY.  The path for saving the key is defaulted to the path enter in the class file
when it was created.  NOTE:  If you change the path in the Save Key dialog box, the saved
key will not be available to the program since it will be looking for the key at the default
location specified by the class file.

6. Exit the Key builder (you will be back to the Menu bar area of MICRO-ErrorChecker
Plus 2006..

7. Select File menu and choose Load document and load the source document from which you
created the last key (you do not need to print the document at this point).

8. Press ESC and when the Document data dialog appears, click on Check document for
errors button.  When the Open KEY File dialog box appears, select the name of the last
key you created (this should be the key for the document you just loaded).  There should be
no errors since the key was made from the source document.  If errors occur, you need to
correct the key; re-enter the Key builder and make the necessary corrections (see step 3
above).

9. Select Return to current job and click on the Continue button.  Edit the current job and
make several errors and changes in all variable areas (if applicable).

  10. Press ESC and when the Document data dialog appears, click on Check document for
errors button.  When the Open KEY File dialog box appears, select the name of the last key
you created (this should be the key for the document you just loaded).  There should be no
errors since the key was made from the source document.  If errors occur, you need to correct
the key; re-enter the Key builder and make the necessary corrections (see step 3 above).

  11. Verify that the errors have been identified properly.  (If the KEY is not correct, re-enter
the Key builder and correct the key.)
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SAMPLE KEYS

On the MICRO-ErrorChecker Plus 2006 program disk set are 4 sample keys:

1. Timed Writing (filename: TW1)
2. Paragraph Drill (filename: PARDR1)
3. Line Drill (filename: LINEDR1)
4. Letter (filename: LETTER1)

The text for these exercises follows:

TIMED WRITING (TW1):

Directions: Type a 1' and 3' timing

This is a sample timed writing that you may practice on to test the error-checking
capabilities of Micro-ErrorChecker Software.  This timed writing is a short three
paragraphs long.

As you test the error-checking of this timed writing you may want to deliberately
make several errors to ensure that the error checker will catch the errors properly.

Remember, a timed writing must be typed in sequence beginning with the first line
of the first paragraph.  If you finish the timed writing before the time period is complete,
repeat the material starting with the first paragraph.

PARAGRAPH DRILL (PARDR1):

Directions: Type each paragraph for 1'; type both paragraphs for 2'

Remember, a paragraph drill may contain one or more paragraphs.  Each
paragraph may be typed independent of the other paragraphs in the drill.

If you desire to type this second paragraph as a three-minute timing you may do so. 
You may also type the paragraphs in any sequence you desire.

LINE DRILL (LINEDR1):

Directions: 1.  Type each line twice; DS between lines
2.  Type lines 1 and 3 twice; DS type lines 2 and 4 once

The typing screen will display a document currently in memory.
The drill line must be a single line that ends in punctuation.
Drill lines are error checked a line at a time from the start.
A paragraph drill may consist of one or more short paragraphs.
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LETTER (LETTER1): 

Directions: Type the following letter as a modified block letter with paragraphs indented;
use mixed punctuation.

Formatting directions:  
Margins should be set at 10 and 75.
Paragraphs should be indented 5 spaces.
Key current date on Line 16.

[use current date] | Ms. Jane R. Sullivan | 3945 East Thunder Ridge Court | Cedar Falls,
IA 50613 | Dear Ms. Sullivan: |

Thank you for your recent inquiry about our new product line.  We are sending you
our most recent catalog published [use the last day of the previous month--for example
March 31, 1995].

If you place an order by December 31, [use current year], you will receive a 20
percent discount [underline the words '20 percent discount'] in addition to the free
promotional gift mentioned in the catalog.

To rush your order, call our toll-free number 1-800-555-3345.  [Type the phone
number in bold.]   Operators are standing by 24 hours a day to take your order.  

Sincerely, | [Use your name here] | Vice President of Marketing | [referenceinitials]
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Student Record Keeping

General Overview:

Your MICRO-ErrorChecker Plus 2006 package comes with a built-in database to track the progress
of classes of students.  This data base consists of three types of files: class roll files, student data
files, and backup files.  These files are created through the MICRO-ErrorChecker Plus 2006
Edit/Create Class.  Using the database manager, you can  manipulate the information stored in
these three types of files.

Here is an explanation of what is stored in each of the three file types:

Class Roll Files: Class Roll Files are used to store lists of student names currently enrolled in,
deleted from, and transferred from a particular class.  These files, found in the
records path,  are named classrec.<ext>. "<ext>" is a three digit representation
of the class code.  For example, the class roll file for class 1 is named
classrec.001.  

Student Data Files: Student Data Files record the results  (words/minute, total words etc.) of a
particular student's Timed Writings,  Line Drills,  Paragraph Drills, Productions
and Exams.  Score results are added to student data files when a student error-
checks his/her document.  The name of a particular student's data file is
determined by combining the first four letters of his/her last name, the first three
letters of his/her first name, and one more letter determined by the software. 
The three digit file extension is again determined by the class code.  For
example, the student data file for Paul G. Mayfield enrolled in class 1 would be
named "mayfpaui.001".  These files are kept in the records path.

Backup Files: Backup files are simply copies of Class Roll and Student Data files.  They can
be used to restore information should it ever become lost.  They use the same
name as the files they back up except that they use a different file extension. 
This different file extension is determined by replacing the numeric digits of the
original file extension with corresponding letters.  For example, the backup file
for "classrec.001" would be named  "classrec.aab".  The backup for
"mayfpaui.020" would be named "mayfpaui.aca".

The MICRO-ErrorChecker Plus 2006 Database Manager and the Student Records Menu System
described in this chapter manipulate the information stored in the above files.  
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The MICRO-ErrorChecker Plus 2006 Database Manager

You can manipulate any of the information in the class roll and student data files using the
database manager utility.  

The Four Main Views:

The database manager is split into four views.  An explanation of each view is described
below:

The Main View

The purpose of this view is to inform you as to the current class roll and current
student being worked on.  The maximum errors, minimum time, and score ranking
standards of the current class are also displayed here.  Pressing the Select Class
button in this view will change what appears in the Function Input View allowing you
to select different class on which to work. Likewise,  pressing the Select button
changes what appears in the Function Input View allowing you to select a different
current student on which to work.  Alternatively, you can change the current student
by pressing the Next  button which sets the current student to the next student enrolled
in the current class alphabetically.
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The Four Main Views of the Data Base Manager (continued):

The Function Select View

The purpose of this view is to select the kind of operation you wish to perform on the
database files.  These kinds of operations are divided into three categories:  operations
on the class roll file,  operations on the student data file, and other operations.   By
clicking on the bullet to the left of each function name (with your mouse), you change
what appears in the Function Input View.  Then, filling out the information requested
in the Function Input View, you complete the operation and save any modifications to
the database files. 

The Function Input View

The purpose of this view is to collect the information necessary  to carry out any given
operation.  For example, if you selected Add Student from the Function Selection
View, the Function Input View would show a form that would allow you to input the
new student name.  It would also provide a button that you would press to commit the
name you entered to the current class roll file.  Using the Function Selection View in
conjunction with the Function Input View allows you to completely manipulate the
database files.

The Message View

The purpose of this view is to communicate any information to you concerning the
operations you perform.  For example, after successfully adding a student to the
current class roll, the message view displays a message confirming the success of the
addition.  Had an error occurred when adding the student to the class roll file, you
would have been appropriately informed through the message view.

Now that you are familiar with the layout and purpose of the above views, you can teach yourself to
use the database manager.  Try clicking on some of the bullets and pressing some of the buttons. 
Ten to fifteen minutes of experimentation will be worth the entire rest of this chapter.

The rest of this chapter describes how to use the fourteen different forms that appear in the Function
Input View.
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The Fourteen Forms of the Function Input View:

      Adding a Student:  Clicking on the Add Student bullet in the Function Selection View causes the
following form to appear in the Function Input View:

If you click inside the box to the right of the Enter Name: prompt, you can enter in a
new student name.  Pressing Add Name to Current Class Roll then saves this name in
the current class roll file.  The current class roll is displayed in the Main View.  After
adding a student, be sure to read the message that will appear in the Message View.
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      Deleting a Student:  Clicking on the Delete Student  bullet in the Function Selection View causes
the following form to appear in the Function Input View:

All currently enrolled students will appear listed in the Select Name  box.   To delete a
student,  scroll through this box until the name you want to delete appears and click on
the name with the mouse.  You will know that you selected the name because it will
appear highlighted in blue and the Main View will show the current student to be the
name you selected.  At this point, simply press the Delete Selected Name from Class
Roll button.  Again, make sure you monitor the Message View to confirm your action.

If you now click on the Print/Display bullet in the Function Select View, and then
click on the  Display Class Roll button in the Function Input View, and then press
the Deleted button in the Roll Display Window, you will see your deleted student
listed.
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      Editing a Student Name:  Clicking on the Edit Student  bullet in the Function Selection View
causes the following form to appear in the Function Input View:

All currently enrolled students will appear listed in the Select Name  box.   To select a
student name to edit, scroll through this box until the name you want to edit appears
and click on the name with the mouse.  You will know that you selected the name
because it will appear highlighted in blue and the Main View will show the current
student to be the name you selected. 

Next, click on the box to the right of the Enter New Name prompt box.  This will
allow you to enter the new spelling for the selected student.

When these two steps are completed, press the Change Selected Name to New Name
button to make the new spelling take effect in the class roll file.   Again, make sure you
monitor the Message View to confirm your action.

After the change, the current student name (displayed in the Main View) will be the
newly edited student name that you entered.
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      Restoring a Student:  Clicking on the Restore Student  bullet in the Function Selection View
causes the following form to appear in the Function Input View:

All currently deleted students will appear listed in the Select Name box.   To select a
student name to restore, scroll through this box until the name you want to restore
appears and click on the name with the mouse.  You will know that you selected the
name because it will appear highlighted in blue and the Main View will show the
current student to be the name you selected. 

To restore this name, press the Restore Selected Student to Class Roll button.  
Again, make sure you monitor the Message View to confirm your action.

If you now display the class roll (see "Displaying the Class Roll File") you will see
that the student you restored has been moved to the enrolled list.

*NOTE:  Restoring a student is different from restoring his/her data file. 
"Restoring a student" re-enrolls him/her in a class roll file from which  he/she has
presumably been deleted.  "Restoring a student data file" replaces the information
in a student data file with the information contained in that data file's backup file. 
For information on "Restoring a student data file", see "Backup options" in this
chapter.
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      Resetting and/or Deleting the Class Roll File:  Clicking on the Reset Roll bullet in the Function
Selection View causes the following form to appear in the Function Input View:

As the prompt warns, these options are extremely dangerous as well as useful.  You
should only use them to clean up your disks when a term ends.  They erase all the
information in the class roll, student data, and backup files.  Pressing Reset the Class
Roll deletes all student data and backup files and sets the class roll file to empty. 
Pressing Delete the Class Roll deletes all student data files and backup files and
deletes the current class roll file as well.  Only the MICRO-ErrorChecker Plus 2006
Edit/Create Class can create a new class roll file.

You should use Reset the Class Roll at the end of a term if you want to "start fresh"
at the beginning of the next term.  Using this option requires you to re-enter in all
student names into the reset class roll file (using the Add Student  bullet).  This is
what you want if enrollment changes from one term to another.  If, however, you want
to reset all the student data files in the current roll file without removing all names
from the current roll file, use the Reset Scores bullet in the Function Selection View.  
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      Adding a Score to a Student Data File:  Clicking on the Add Score  bullet in the Function
Selection View causes the following form to appear in the Function Input View:

The Exercise Name, Saved As, Words, Errors, Checks, Edits, GWM, NWM, and
CWM fields can be edited by clicking the mouse in the box to their immediate rights
and typing in the values to which they should be set.  All other fields are edited by
pressing the corresponding increment and decrement buttons.  Select the score type of
the score you will add by pressing the Change Type button until the desired score type
is displayed to the right of the Score is: prompt.

When you have the desired values entered for all fields, press the Add Score as Shown
button.  This will add the score that currently appears to the current student's data file 
(the current student is displayed in the Main View).

The following table describes the meaning of each field:

Exercise Name: The exercise name (the name of key document used by the Error
Checker).

Saved As:  The document name (as saved on disk).
Words:  The total number of words.
Errors:  The total number of errors.
Date:  The error-check date.
Checks:  The number of times the exercise was error-checked.
Edits:  The number of times the exercise was edited.
Time:  The time of day the exercise was error-checked.
GWM:  The Gross Words per Minute rate.
NWM:  The Net Words per Minute rate.
CWM:  The Cut-off Words per Minute rate.
Elapsed Time:  The total elapsed time taken for the exercise.
Correction  Whether the correction feature was ON or OFF.
Exercise Type: The type of exercise (only valid for exams/productions).
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      Deleting a Score from a Student Data File:  Clicking on the Delete Score bullet in the Function
Selection View causes the following form to appear in the Function Input View:

Use the Change Type button to select the score type of the score you wish to delete. 
Then press the Next Button (next score in record) or the Prev Button (previous score
in record) until the score you wish to delete appears in the fields of this form.

When you have selected the score to delete, press Delete to remove it from the current
student data file.  

*NOTE:  Editing any of the fields in this form has no effect.  You must select the
score you wish to delete by using the Change Score Type Button, Decrement Score
Button, and the Increment Score Button.
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      Editing a Score in a Student Data File:  Clicking on the Edit Score bullet in the Function
Selection View causes the following form to appear in the Function Input View:

Use the Change Type button to select the score type of the score you wish to delete. 
Then press the Next Button (next score in record) or the Prev Button (previous score
in record) until the score you wish to delete appears in the fields of this form.

Once you have the score you wish to edit displayed in the fields of this form, use the
mouse and keyboard to edit any of the various fields to the new values you desire. 
Then press the Save button to commit the changes to the student data file.

Monitor the Message View to confirm the success of  your action.

The following table describes the meaning of each field:

Exercise Name: The exercise name (the name of key document used by the Error
Checker).

Saved As: The document name (as saved on disk).
Words: The total number of words.
Errors: The total number of errors.
Date: The error-check date.
Checks: The number of times the exercise was error-checked.
Edits: The number of times the exercise was edited.
Time: The time of day the exercise was error-checked.
GWM: The Gross Words per Minute rate.
NWM: The Net Words per Minute rate.
CWM: The Cut-off Words per Minute rate.
Elapsed Time: The total elapsed time taken for the exercise.
Correction Whether the correction feature was ON or OFF.
Exercise Type: The type of exercise (only valid for exams/productions).

      Resetting Student Data Files:  Clicking on the Reset Scores bullet in the Function Selection
View causes the following form to appear in the Function Input View:
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As the prompt warns, these options are extremely dangerous as well as useful.  They
erase all the information saved in student data files.  This is useful when you start a
new term with the same class and wish to start recording scores from scratch.  It is
also useful to give a student with a corrupted data file a new data file from which to
work.

Press Reset Current Data File to reset the current student's data file leaving him/her
with no recorded scores.  Press Reset All Data Files to reset the data file of every
student enrolled in the current class roll file.

*NOTE:  It is strongly recommended that you backup the class (see backup
options) before using these options.  This will allow you to reverse the effects
of using these options if you choose to later.
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      Print / Display Options:  Clicking on the Print / Display bullet in the Function Selection View
causes the following form to appear in the Function Input View:

Press Display Class Roll to bring up the Roll Display Window (see Roll Display
Window).

Pressing Display Passwords also brings up the Roll Display Window, but the students
have their passwords displayed along with their names.

Press Display Scores to bring up the Student Score Display Window (see Student Score
Display Window).

Press Student Record to Printer to send a report of the all the current student's recorded
scores to the default printer.  Make sure the printer is available, connected, and ready.

Press Class Summary to Printer to send a report to the default printer containing the
following: 1- a printout of the class roll file, 2- a print out of the student record for each
enrolled student in the current class roll.
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      Merge / Transfer Options:  Clicking on the Merge / Transfer bullet in the Function Selection
View causes the following form to appear in the Function Input View:

To transfer a student from one class to another: 

? Type the name of the student to transfer in the Sending Name Box
? Type the code of the class in which this student is currently enrolled in the

Sending Code Box 
? Type the class code to which this student should be transferred in the Receiving

Code Box.  
? What's contained (if anything) in the Receiving Name Box has no effect on the

transfer.
? Press the Transfer Records button to complete the transfer.  Make sure you

monitor the Message View to confirm the success of your action.

To merge two student records: 

? Type the name of the student sending the merge in the Sending Name Box.  The
sending student in a merge is the student whose record will be erased after the
two student records are merged.  

? Type the code of the class in which the sending student is currently enrolled in
the Sending Code Box.  

? Type the name of the receiving student in the Receiving Name Box.  The
receiving student in a merge is the student whose record will be retained after
the scores in his/her student data file are merged with the scores in the sending
student's data file. 

? Type the class code of the class in which the receiving student is currently
enrolled in the Receiving Code Box.  

? Press the Merge Records button to complete the merge.  Make sure you monitor
the Message View to confirm the success of your action.
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      Backup / Restore Options:  Clicking on the Backup / Restore bullet in the Function Selection
View causes the following form to appear in the Function Input View:

The following explains what each of these buttons does:

Backup Class Updates the backup files for the current class roll
file and the student data file for each currently
enrolled student.

Backup Roll Updates the backup file for the current class roll
file.

Backup Student Data File Updates the backup file for the current student's
data file.

Restore Class Replaces the information in the current class roll
file and the student data file of each student
enrolled in the backup class roll file with the
information found in their respective backup
files.

Restore Roll Replaces the information in the current class roll
file with the information found in its backup file.

Restore Student Data File Replaces the information in the current student's
data file with the information contained in his/her
backup file.

Be sure to monitor the Message View to confirm the success of your action.
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Changing the Current Class Roll:  Pressing the Select Class button in the Main View causes the
following form to appear in the Function Input View:

You may select the class code of the new class you which to view by typing the code in the
box to the right of the Please enter new Class Code prompt or by using the scroll controls
to increment or decrement the currently displayed value.  Then, press the Switch to new
Class Code button to load in the new class.  Make sure you monitor the Message View to
confirm the success of your action.
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Changing the Current Student:  Pressing the Select button in the Main View causes the following
form to appear in the Function Input View:

All currently enrolled students will appear listed in the Select Name  box.   To select a
new current student, simply scroll through this box until the name you want to select as the
new current student appears and click on this name with the mouse.  You will know that
you selected the name because it will appear highlighted in blue and the Main View will
show the current student to be the name you selected. 
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      The Roll Display Window:  Clicking on the Print / Display bullet in the Function Selection View
and then pressing the Display Class Roll  button or the Display Passwords button in the Function
Input View causes the following window to appear.

Pressing Enrolled lists the students enrolled in the current class roll  (when the
window is first opened, the enrolled students are listed by default).

Pressing Deleted lists the students that have been deleted from the current class roll.

Pressing Transferred lists the students that have been transferred from the current
class roll.

Pressing Print  sends a report listing the currently enrolled, deleted, and transferred
students (if any) to the default printer.

Pressing Return returns to the Database Manager.
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      The Score Display Window:  Clicking on the Print / Display bullet in the Function Selection
View and then pressing the Display Scores  button in the Function Input View causes the
following window to appear.

              < Header Section

              < Score Display Box

              < Footer Section

                 < Sort Order Section

The first line in the Header Section shows the current student.  The second line displays
the type of scores being displayed along with the current date.  The third line indicates how
the software deals with multiple scores saved with the same exercise name.  

The Score Display Box lists the scores recorded of the current type. The following
explains the information that appears in the columns of this box:

Exercise The exercise name (the name of key document used by Error Checker).
Saved As The document name (as saved on disk).
Date The error-check date.
Done At The time of day the exercise was error-checked.
Cor Whether the correction feature was ON or OFF.
Er The total number of errors.
GW The Gross Words per Minute rate.
NW The Net Words per Minute rate.
CW The Cut-off Words per Minute rate.
Time The total elapsed time taken for the exercise.
Wrd The total number of words.
Edits The number of times the exercise was edited.
Checks number of times the exercise was error-checked.

The Footer Section displays information pertinent to the scores displayed in the Score
Display Box.   If you select a score by clicking on it (in the Score Display Box) with
your mouse, the qualification status of that particular score will be displayed in the
Footer Section if the current score type is Paragraph Drill, Line Drill or Timed
Writing -- otherwise the exercise type of the selected score is displayed.  See
"Qualifying Scores" on the next page.
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The Score Display Window (continued):

Pressing Return returns to the Database Manager.  
Pressing Print  Scores sends the information currently displayed to the default printer.
Pressing Next Student displays the scores of the next student enrolled in the current

roll file.
Pressing Next Score Type changes the type of scores displayed  (exams, line drills

etc.).

The Sort Order:

Line Drills, Paragraph Drills, and Timed Writings are always displayed in order of
rank where qualifying scores with higher word/minute rates and fewer errors rank
highest.  Scores that do not qualify (see "Qualifying Scores") are either placed at the
bottom of the list or simply not recorded if the list is full of qualifying scores.  The
Database Manager records only the best ten scores of these types and displays only as
many of these ten as you specify in the MICRO-ErrorChecker Plus 2006 Setup.  

The Sort Order Selector is only enabled when the current score type is either Exams
or Productions.  It is used to select the order in which exams and productions are listed
in the Score Display Box.  By clicking on the appropriate check box, you select one of
the following sort orders:

Save Lists the scores in the order in which they were saved (error-checked).
Name Lists all scores with a given exercise name.  You are prompted for the

name when you click on the check box.
Date Lists the scores by order of their recorded dates.
Recent Lists all scores whose recorded date falls after a date that you are

prompted for when you click on the check box.
Grouped Lists the scores in alphabetical order using the exercise name.
Unique Lists the scores in alphabetical order using the exercise name such that

scores with the same exercise name are listed only once.  When you use
this sort order, the "Ch" column in the "Score Display Box" is changed to
"#" to indicate that the number of occurrences of a particular exercise
name are displayed in that column.

Qualifying Scores:

A score "qualifies" if it is a Line Drill, Paragraph Drill, or Timed Writing and if it
has fewer than the "maximum errors standard" for the current class.  Timed Writings
must also meet the "minimum time standard" for the current class to qualify.  If
multiple saves of the same exercise name are not permitted (as designated in the
Setup), then only the first, last, or best score saved will be considered to qualify
depending on the designation through the Setup.

The Footer Section displays how many scores qualify (if applicable) as well as
whether the number of scores that qualify meets the number of scores that the class
requires as designated in the MICRO-ErrorChecker Plus 2006 Setup.
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The Score Display Window (continued):

Selecting Scores:

Whenever a list of scores appears in the Score Display Box  you can point to any of
the listed scores and click the left mouse button.  This will "select" the clicked-on
score.  When a score is selected, it is highlighted in blue and additional relevant
information concerning the score is displayed in the footer section.  When a Line Drill,
Paragraph Drill, or Timed Writing is selected, its qualification status is displayed in
the footer section.  When an Exam or Production score is selected, its Exercise Type is
displayed in the footer section.

Exam Summaries:

When you display exam scores by date (by clicking on the date check box in the Sort
Order Selector), you can bring up the "Exam Summary Window" by selecting a score
in the Score Display Box.

This window calculates the total time elapsed, average errors, and word/minute rates
for every exam score recorded with the same date as the score you selected.  
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The MICRO-ErrorChecker Plus 2006 Student Record Menu System

You'll notice that the layout of the Student Records Menu System looks almost
identical to that of the "Score Display Window" under the Database Manager.  In fact,
they operate in exactly the same manner except that the push buttons at the bottom
perform different functions.  Here is a summary of the push buttons for the student
menu system:

Pressing Next Score Type changes the type of the scores displayed ("Timed Writings"
etc.).

Pressing Reload reloads the displayed scores from the data file.  This is only useful if
the student menu window is left open while the student continues to type and error-
check exercises in the word processor (i.e., update the student data file from the word
processor).

Pressing Print  sends a report of the currently displayed scores to the default printer.

Pressing Print All  sends a report of all recorded scores in the student data file to the
printer.  

Pressing Backup backs up the current student data file.  This button is only enabled if
the backup option in the MICRO-ErrorChecker Plus 2006 Setup was designated as
Backup MENU.

Pressing Exit closes the Student Menu System Window.
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TROUBLE SHOOTING

Please trouble shoot the problem before calling for Technical Assistance

Important information is contained in several sections of the manual.  The solution to your problem may
be covered in one of these sections.

1. Read  QUICK REFERENCE FOR MICRO-ErrorChecker Plus 2006 (User's Manual, page 1).

2. Read the EQUIPMENT REQUIREMENTS (User's Manual, page 17).    

3. Read the INSTALLATION OF MICRO-ErrorChecker Plus 2006 (User's Manual, page 9).

4. Read the ORIENTATION TO MICRO-ErrorChecker Plus 2006 (User's Manual, page 26).

5. Trouble shoot the problem

a. Printing Problems–Micro-ErrorChecker Plus 2006 uses the Windows Default Printer.  If
printing problems occur make certain that the correct printer has been set as the default printer,
that the printer is currently connected, and operating properly.  To test the printer go to START-
>SETTINGS->PRINTERS, and double-click on the desired printer.  Pull down the PRINTER
menu and make sure it is set as the DEFAULT printer.  From the properties option on the
PRINTER menu you may also print a test page to be certain that the printer is operating
properly.. 

b. Printing Problem -- Margin(s) is/are not the correct size.  Please see item 5a above.  This
problem may also be caused by an incorrect alignment of the paper feeding into the printer. 
Select PICA and then type a character at space number 1 (the left edge of the screen) and print
the page.  This character should be printed at the left edge of the paper (flush with the perforation
on continuous form paper).  Adjust the paper guides on your printer if the character is not flush
with the left edge of the paper.

c. Line spacing problem--printed copy is double-spaced when the line spacing is set for single
spacing.  This is a printer problem (see 5a above).

d. No directory of saved documents.  This problem is generally a result of an incorrect drive or
path specified in the Edit/Create Class option on the Teacher menu.  Double check the Storage
Path specified.  Other possibilities are a damaged diskette, or the wrong diskette being in the
drive.

e. Path Does Not Exist Error and other disk related errors.  These errors may occur when the
storage disk is damaged, unformatted, or not in the disk drive.  The error may also occur when a
network mapping is unavailable.  Disk errors also occur when disk drives need cleaning, when
drive heads need realignment, when the diskette has been damaged, and/or when the diskette has
worn out.  For errors relating to floppy disks,  identify the source of the difficulties by following
these steps.
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1. Visually check the diskette surface for fingerprints, pencil or pen marks or other signs of
physical damage.  If damage is evident, replace the diskette.

2. Check the diskette for hidden damage (bad sectors, etc.)  It will be necessary to use a disk
utility for this check.  If the diskette shows hidden damage, replace the diskette.

3. If the diskette shows no damage, the disk drives should be cleaned.  Disk drives should be
cleaned on a regular basis.  Frequency of cleaning is based on hours of use, external
sources of dust (chalkboards, windows, students, etc.)

4. If the above three steps do not solve the problem, it may be necessary to align the disk
drives.  Alignment of drives requires a qualified technician, and may be rather expensive. 
The less expensive solution to this problem is to format the diskette in the actual drive
that will be used with the diskette, and then to not use the diskette on other computers or
in other drives on the same computer.

Some common disk related errors are listed below with their common causes:

Cyclic Redundancy Check:  Fingerprints on the disk or other physical damage will often be
the cause of this error.  Try a different diskette.  If the error persists, drive cleaning or
alignment may be the problem.
General Failure:  The diskette has either not been formatted, or is formatted in a manner that
is incompatible with the disk drive.  (i.e. a high density diskette in a double density drive.)
Sector Not Found:  Probably a damaged diskette.  Try a different diskette.  If the error
persists, clean the disk drive and check the alignment

f. Network problems.  Most network problems are caused by incorrect drives and paths in the
Edit/Create class item of the Teacher menu or the incorrect network access rights for users. 
The drives and paths specified in the Edit/Create class item of the Teacher menu of MICRO-
ErrorChecker Plus 2006 must be valid drives and paths and must be available at all times
Micro-ErrorChecker Plus 2006 is being used.  See page 108 for information on network access
rights.  To check the availability of a specific network drive and path double-click on the My
Computer icon; if the specified drive or path is not available in My Computer, it will not be
available to MICRO-ErrorChecker Plus 2006 either.  

g. Movement of cursor displays unwanted character.  The screen display is out of
synchronization with memory.  Press CTRL-F10 to bring the screen and memory into
synchronization.

h. Delete key beeps.  One of the following functions is on:  Center, Justify, or Decimal Tabs. 
Turn these functions off for normal delete operation.

i. No forms are available on this disk.  The Form Path specified in the Edit/Create Class item of
the Teacher menu is incorrect.  Redo the Edit/Create Class for this particular class.

j. Any key beeps.  Correction is OFF, and your cursor is not positioned at the end of the document. 
Move the cursor to the end of the document (press CTRL-END).

k. Input/Output error.  This error often indicates that the storage disk is full.  This error may also
indicate a damaged diskette.

l. Dot command invalid in this location.  A MICRO-ErrorChecker key was created for a
multiple-page document indicating that a second page header or footer existed, but no sample
header of footer was created for the key.  Return to the Key builder and load the previously
created key.  Select  Create/Edit sample HEADER or Create/Edit sample FOOTER.  After
creating the sample header or footer, remove all headers or footers from the text and re-save the
key.  (See the section on the Key builder for more information.)
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Before phoning for assistance, please have the following information available:

a) Have a complete listing of the current options set in the Edit/Create Class options for the class
or be at a computer where you can access the Edit/Create Class dialog for the concerned class. 

b) Computer make and model including memory size.
c) WINDOWS 95/98 or Windows NT/2000/XP version number.
d) Printer make and model.
e) Network name and version number (if applicable.)

When phoning for assistance please call from a phone at a computer workstation.

TECHNICAL ASSISTANCE: 1-801-277-9444

Technical Assistance Hours: 9:00 am - 2:00 p.m. Mountain Time Zone

NOTE:  In an effort to keep our software prices as low as possible for the schools, this is not a
toll-free number; however, we do provide the technician's service to you at no additional
charge.
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SECURITY

MICRO-ErrorChecker Plus 2006 provides several means to assure that students do not falsify the
results of their work and not copy from other students.  These means include the following:

Edit Counts Each MICRO-ErrorChekcer Plus 2006 Document
stores in it the number of times it was edited.  By
requiring students to hand in only documents that have
a zero edit count, you insure that they have not
corrected mistakes from a previous document.

Check Counts In addition to edit counts, each MICRO-ErrorChecker Plus 2006
Document stores the number of times a particular exercise is error-
checked. Documents that have only one check count and a zero edit
count have legitimate scores that have not been falsified. 

Encryption of documents All MICRO-ErrorChecker Plus 2006 documents are
encrypted before they are saved to the storage disk to
ensure the integrity of the data they contain.

Notice that for best security, the edit count must be  0 and the check count must be 1
for any given document.
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APPENDIX A
SPECIAL NETWORK CONSIDERATIONS

Most Networks:
The following describes the file attributes and user access rights associated the with directories that you

specify through the setup program:

Directory Attributes User Access

Program* All Files Shareable / Read / Write Students Read / File Scan
Teachers Read / Write / Create  

Delete / File Scan

Records All Files Shareable / Read / Write Students: Read / Write / Create 
File Scan / **

Teachers: Read / Write / Create 
Delete / File Scan / **

**Recommend giving both Students and Teachers FULL RIGHTS

Keys All Files Shareable / Read / Write Students:  Read / File Scan
Teachers: Read / Write / Create 

 Delete / File Scan

Storage Should either be a floppy or a network drive letter mapped to the individual's home
directory.  (There would be no subdirectory indicated in the setup.)  Each individual
should have all rights to his/her storage drive.

(*NOTE: On a standard hard disk installation this would be c:\Program
Files\MECPlus2006\.)

NOTE TO NT/2000 SERVER USERS: When granting access rights on NT/2000 Servers
use the "Special Access Privileges" to grant the rights listed above to both the directories
and to the files in the folders.  (For some reason on NT Server 4.0, the use of "All Rights"
sometimes does not actually grant any rights.)



109

Lantastic Specific Guidelines:

The following describes the file attributes and user access rights associated the with directories that you
specify through the setup program:

Directory Attributes

Program All Files READ ONLY* Directory = Shareable

Records classrec.### Files: READ ONLY*
All Other Files: Read / Write Directory = Shareable

Keys All Files:  READ ONLY* Directory = Shareable

Storage All Files: Read / Write

*NOTE: When the files in these directories are to be modified (see below), you must temporarily
give them read/write attributes (read only / read-write attributes can be granted to files
and folders by selecting the file or folder in MY COMPUTER and selecting
PROPERTIES from the FILE menu).  After the modification is complete, change their
attributes back to read-only.  The following table explains when to make these attribute
changes:

Directory When it needs to have its attributes changed

Form When running the MICRO-ErrorChecker Plus 2006 
(MICRO-ErrorChckerPlus2006->Teacher->Edit/Create
class) the program files need to have read/write access. 

Records When running the Database Manager 
(MICRO-ErrorCheckerPlus2006->Teacher->Student
records).  The student record files need to have read-write
access.  

Keys When running the Key builder utility 
(MICRO-ErrorCheckerPlus 2006->Teacher->Key
builder), all files should have read-write access.

For the convenience of the teacher, it is recommended that the network administrator
create batch files to modify the above attributes.
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APPENDIX B
POLICY TEMPLATES

Installation of Micro-ErrorChecker Software makes entries to the Windows Registry.  Networks using
individual or group user profiles providing a Custom Windows Registry to the user at logon time should
use Policy Templates to add the necessary entries to the Custom Windows Registry.  Abbreviated
instructions follow.  For more detailed information, please see your Operating System's documentation.

Example of Abbreviated Instructions for Using Policy Templates for Windows NT:
1.   Create a text file containing the text shown below.  (The file shown is for a very basic Windows NT

installation.  Please customize the file as reauired for your specific network configuration.)  Save the
file with a .ADM extension.

2.  Copy the text file to the C:\WINNT\INF folder on the server.
3.  Select Start -> Programs -> Administrative Tools -> System Policy Editor.
4.  Select Options ->Policy Template.
5.  Select Add.
6.  Navigate to the C:\WINNT\INF folder and double-click on the file you created.
7.  Click on OK.
8.  Select File -> Open Registry.
9.  Select the appropriate registry.  (If you aren't sure, it is probably Local User, but please check with

your network administrator.)
10. Click on the plus (+) sign to the left of the S. E. Warner Software Settings.  Click on the individual

check boxes and enter the correct path or link.
11. Click on OK.
12. Select File -> Exit.
13. Select Yes to save changaes to the registry.

;    Policy Template for Micro-ErrorChecker Software Version 2006
;    Sets Registry Entries for MEC2006 when Policies are in use.

CLASS USER
CATEGORY !!SEWSetMEC2006
KEYNAME "Software\SEWarner\MICRO-ErrorChecker\2006"
POLICY !!SetPathMEC
PART !!Path EDITTEXT
VALUENAME "Program Path"
END PART
END POLICY
POLICY !!SetDefaultsPathMEC
PART !!Path EDITTEXT
VALUENAME "Defaults Path"
END PART
END POLICY
END CATEGORY
[strings]
SEWSetMEC2006="S. E. Warner Software Settings MEC2006"
SetPathMEC="Set Program Path for Micro-ErrorChecker 2006"
SetDefaultsPathMEC="Set Defaults Path for Micro-ErrorChecker 2006"
Path="Path"
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WARRANTY STATEMENT

SITE LICENSE DISKS

Use the software for 90 days and then if not completely satisfied,
return it for a refund.  If a purchaser receives any master disks
that are defective, please return them immediately for a
replacement.

GENERAL STATEMENT

There are no warranties beyond those described on the face hereof
and all implied warranties, including implied warranties of
fitness and merchantability, are hereby excluded.

ORDERS  1-801-277-9444

TECHNICAL ASSISTANCE  1-801-277-9444


